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About This Book

Purpose
The Intuity™ Message Manager Release 2.0 User's Guide (585-310-731) is 
intended to introduce new users to the Message Manager application.  
Coverage of this PC-based message-handling tool includes instructions for 
retrieving, creating, and sending voice and/or fax messages, saving 
messages on disk, storing addresses in a Personal Phonebook, and using 
AUDIX features through the convenience of your PC.

Intended Audience
This book is intended for new users of the Message Manager application.  
Readers should have a basic familiarity with Microsoft® Windows™ 
software.  Specifically, you should already know how to use windows, 
dialog boxes, and pulldown menus.  You should also be familiar with 
using your AUDIX® messaging system.

How This Book Is Organized
This document is organized as follows:

■ Chapter 1, "Introduction," summarizes Message Manager features, lists 
the hardware and software requirements for running Message 
Manager, and describes how to install the software.
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■ Chapter 2, "Getting Started," describes the application's main screen, 
provides information about online help, and tells you how to exit, 
minimize, or lock Message Manager.

■ Chapter 3, "Handling Incoming Messages," covers the most common 
tasks such as listening to, moving, and deleting messages.

■ Chapter 4, "Creating and Sending Messages," tells you how to create, 
record, address, or forward a message as well as selecting options and 
scheduling message delivery times.

■ Chapter 5, "Personal Phonebook," tells you how to manage your 
Personal Phonebook databases, and how to add, edit, delete, select, and 
print card entries.

■ Chapter 6, "Other Standard Features," covers more sophisticated 
Message Manager features such as recording personal greetings and 
creating and editing mailing lists.

■ Chapter 7, "Fax Feature," tells you how to receive, view, print, and send 
a new or stored fax.

■ Chapter 8, "More About Message Manager," describes using your 
Personal folder, working with the AUDIX server and telephone 
interface, as well as remote accessing.

■ Chapter 9, "Troubleshooting," helps you solve Message Manager 
installation and user problems.

■ Appendix A, "Hot Keys," covers keyboard shortcuts for Message 
Manager users.

■ A glossary of terms and an index appear at the end of this document for 
your convenience..

Conventions Used
This document uses the following conventions:

■ Text that you type or enter appears in bold type.
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■ Screen names, field names, menu items, and keyboard keys are shown 
with the first letter capitalized.  For example:  use the Card Contents 
fields on the Personal Phonebook screen, select Print from the File 
menu, or press the Enter key.

■ Screen buttons that you can select appear in bold type, such as the OK 
or Cancel button.

Trademarks and Service Marks

The following trademarked products are mentioned in this document:

■ AUDIX® is a registered trademark of AT&T

■ DEFINITY® is a registered trademark of AT&T

■ Intuity™ is a trademark of AT&T

■ MERLIN LEGEND® is a registered trademark of AT&T

■ Microsoft® Windows™ are trademarks of Microsoft Corp.

■ Novell® and NetWare® are registered trademarks of Novell Inc.

Related Documentation
In addition to this user's guide, the following information is available to 
assist you with Message Manager:

■ Message Manager's online help system provides instant information 
about buttons, screens (dialog boxes), and fields.  See the ‘‘Using Online 
Help’’ section in Chapter 2 of this guide for details.  

■ A Message Manager tutorial is available on a separate diskette shipped 
with your Message Manager software.  The tutorial covers basic 
Message Manager features and provides practice exercises to test your 
knowledge.  You may wish to install the tutorial temporarily while 
you're learning Message Manager features.  
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■ Message Manager works in conjunction with the AUDIX messaging 
system accessible through your telephone.  Contact your system 
administrator to get a copy of the quick-reference or wallet cards used 
to support the AUDIX telephone interface.

■ The AUDIX system administrator has access to a complete library of 
documentation that addresses the Message Manager feature from the 
AUDIX server perspective.  Refer to your DEFINITY AUDIX R3.1 and 
R3.2 (voice messaging only), or Intuity AUDIX R3.2 (voice messaging 
only), and R3.3 (voice-fax messaging) library for planning, installation, 
administration, troubleshooting, or feature information.

How to Make Comments About 
This Book

A reader comment card is provided with this document.  While we have 
tried to make this document fit your needs, we are interested in your 
suggestions for improving it.  

Please complete and return the enclosed reader comment card.  If the 
reader comment card has been removed, send your comments to:

AT&T 
Product Documentation Development Department
Room 22-2C11
11900 North Pecos Street
Denver, Colorado 80234

Please include the name, issue number, and order number of this 
document with your comments.
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1Introduction

Welcome to Intuity Message Manager, a tool that lets you handle your 
voice and fax messages from the convenience of your PC.  

Message Manager provides you with a new way of accessing your AUDIX 
messaging system through a Local Area Network (LAN).  The AUDIX 
system is referred to as the AUDIX server when Message Manager 
connects to it over the LAN.



Introduction

2 Issue 1   January 1995

Message Manager Features
This Windows-based application provides the following features:

■ Viewing up to 15 message summaries (headers) at a time and listening 
to messages in the order you choose.

■ Giving you ongoing access to your AUDIX messages, so you don't have 
to call the AUDIX system and re-enter your extension and password 
every time you want to access your messages.  

■ Notifying you of new messages in a variety of ways including visual 
indication, pop-up message boxes, and the Outcalling feature.

■ Giving you access to AUDIX features using either the mouse or 
keyboard commands.

■ Simplifying personal greeting management.

■ Creating and updating stored message-distribution lists (mailing lists) 
visually, and printing these lists.

■ Allowing you to print reports for messages you send or receive.

■ Allowing you to store (archive) voice messages and their associated text 
(the message header) on a separate storage device.

Because Message Manager uses a standard Microsoft Windows interface, it 
works like other Microsoft Windows applications.  It uses icons, pulldown 
menus, a toolbar, and other familiar Windows elements.

Readers of this guide should already be comfortable working in Microsoft 
Windows.  You should also be experienced in using the AUDIX messaging 
system from your telephone (referred to as the AUDIX telephone interface 
throughout this manual).
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Release 2.0 Features

Message Manager Release 2.0 provides the following additional features:

■ A Personal Phonebook for storing addresses and other important 
information on your PC, independent of the AUDIX server.

■ An Outgoing folder for checking the status of messages you have sent, 
and resubmitting these messages in case of delivery problems.

■ Remote access to INTUITY Message Manager, allowing you to retrieve 
your messages visually while off-site (for example, in a hotel room).

Fax Option

In addition to the regular Release 2.0 features, you can install the optional 
fax application.  The fax-messaging feature allows you to:

■ View and print faxes you receive.

■ Store fax messages for future delivery or send them immediately.

■ Attach a voice message to a fax, or send just a fax.

■ Help control your fax costs through higher networking speed and 
reducing your analog port needs.

■ Print only the fax messages you choose to, ensuring privacy.

■ Create fax messages from any Windows application without printing a 
hard copy.

■ Archive fax messages on your hard drive or disk system.

The fax option is available if you have a fax-enabled server (currently only 
INTUITY AUDIX Release 3.3).

Pre-Installation Requirements
Before you install Message Manager, you must verify that you have the 
necessary hardware and software installed on your PC.  You also need to 
make sure your PC is ready to support Message Manager.
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Hardware and Software Requirements

Verify you have the following minimum hardware and software:

■ 486 personal computer running at 33 MHz or faster, with 8 megabytes 
(Mbytes) of RAM and 8 Mbytes of available hard disk storage for the 
application software (minimum recommended requirements).  The 
tutorial requires an additional 8 Mbytes of disk storage if installed.

■ VGA or higher (color or monochrome) monitor.

■ Microsoft Windows version 3.1 or higher, or Windows for Workgroups 
3.11 or higher (to check your version, select About Program Manager 
from the Windows Program Manager Help menu).

■ Microsoft MS-DOS version 5.0 or higher (to check your version, type 
ver at the MS-DOS prompt).

■ Local Area Network (LAN) interface card.

■ Connectivity to the AUDIX server through TCP/IP with a Windows 
Sockets interface (a directory containing a WINSOCK.DLL file must be 
in your DOS path).  Your LAN administrator can help set this up.

■ Optional.  Mouse that is supported by Microsoft Windows (this allows 
you to take full advantage of the Windows interface).

Installation Prerequisites

Before you install Message Manager, make sure your PC and LAN are 
ready to support Message Manager as follows:

■ On your PC, log into the LAN and bring up Microsoft Windows.

■ Get a server name or TCP/IP address of a machine in your network 
from your LAN administrator, then run the ping program from a DOS 
box in Windows ("ping" the address or name).  Ask your LAN 
administrator how to access or use this utility if you need help.

■ If the ping fails or the system hangs, refer to Chapter 9, 
‘‘Troubleshooting’’.  Message Manager will not work if a ping from 
Windows fails.
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■ The basic Message Manager voice application software includes the 
following diskettes:

— Two (2) Message Manager diskettes (required)

— Two (2) Electronic Tutorial diskettes (optional)

To install the optional fax application software, you should also have:

— One (1) fax diskette

Message Manager Installation
To use Message Manager, you must install the software onto your PC (or a 
LAN storage device).  You can install Message Manager either from a 
diskette or from the LAN server as described in this section.

Upgrading to Message Manager Release 2.0

If you plan to upgrade to Message Manager Release 2.0, do the following 
before installation:

■ If you wish to save your Release 1.0 software, be sure to enter a different 
directory name and program group when you install Message Manager 
(see steps 5 and 6 in the following procedure).

■ Do not install Message Manager Release 2.0 with Message Manager 
Release 1.0 running.

Installing Message Manager Release 2.0 
from Diskette

To install the basic Message Manager Release 2.0 voice application 
software from a diskette:

1. Turn on your PC and bring up Microsoft Windows (if not already up).

2. Insert the Message Manager voice application software diskette #1 into 
the disk drive of your PC (for example, the a: drive).

3. In Windows Program Manager, select Run from the File menu.
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4. Run Setup from the Command Line field.  For example, if you inserted 
the diskette in drive a:, type a:\setup in the Command Line.

5. Select the directory in which to store the Message Manager software.  
The default is C:\MSG_MGR.

If you are upgrading Message Manager from Release 1.0, choose a 
different directory name if you wish to save your 1.0 version.  
Otherwise, the Release 2.0 software will overwrite it.

6. Select the program group to contain Message Manager icons.  The 
default is INTUITY Message Manager.

7. Select the Continue button.

8. Insert diskette #2 when prompted.  Select the OK button.

9. When the installation is complete, you may view the README file by 
selecting Yes, or return to Windows by selecting No.  The README file 
contains information about interactions with other PC applications.
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When installation is complete, the first three icons appear on your 
Windows desktop in the INTUITY Message Manager program group (the 
last two icons appear if you install the tutorial):

See the following chapters for more information on these icons:ν

■ INTUITY Message Manager:  Chapter 2

■ INTUITY Message Manager Help: Chapter 2

■ Personal Phonebook:  Chapter 5

■ INTUITY Message Manager Tutorial:  Chapter 1

Installing the Fax Option

You can install the optional Message Manager fax application now or at a 
later time.  To install the Message Manager fax software from a diskette:

1. Turn on your PC and bring up Microsoft Windows (if not already up).

2. Insert the Fax software diskette into the disk drive of your PC (for 
example, the a: drive).

3. In Windows Program Manager, select Run from the File menu.

4. Run Setup from the Command Line field.  For example, if you inserted 
the diskette in drive a:, type a:\setup in the Command Line.

5. Install to the same directory that contains the rest of your Message 
Manager files.  The default is C:\MSG_MGR.

6. Select the Continue button.  The fax software loads.
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7. The INTUITY Message Manager Fax Setup screen then appears.  Enter 
the following information (needed when you create a fax):

— AUDIX Server ID.  This is the name or IP address of the fax-enabled 
server you use to send or receive messages.  See your LAN or 
system administrator for this information if needed.

— Mailbox Extension.  This is the extension number of the fax-enabled 
mailbox you'll be using to send and receive voice and/or fax 
messages.  This is usually the same number as your regular AUDIX 
mailbox.  Users with secondary fax extensions should not enter that 
number here, but type their regular mailbox extension.

8. Select the OK button to add this information.  If you select Skip, you 
can add the information later using the Fax Options screen as described 
in Chapter 7, ‘‘Fax Feature’’.

9. The installation is complete.  To view fax-related information in the fax 
FREADME file, select Yes.  To return to Windows, select No.

Installing Message Manager from the Server

LAN administrators can distribute copies of Message Manager from a 
LAN server instead of having each user install Message Manager from 
diskette.  Ask your LAN administrator how to install Message Manager 
from a LAN server.  General guidelines appear in this section.

Make sure you have sufficient storage space either on the user's PC 
or on the network storage device for each copy of Message Manager.

Sample Administrator Steps.  The following steps show a sample server 
installation on a Novell network running NetWare software.  These steps 
are guidelines only.  Generally, the Novell LAN administrator should:

1. Have a drive letter mapped to the NetWare server that the Message 
Manager software is to be copied to.

2. Create a directory for the Message Manager software on the network 
server.  The directory name could be MSG_MGR or any other name.  
Be sure to copy both Message Manager voice application diskettes into 
the same directory.
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Do not run Setup!  For example, use a standard MS-DOS copy 
command or Windows File Manager to copy the diskettes.

3. Optional.  If you ordered the optional fax software, create a different 
directory on the network server, then copy the fax application software 
into it.  The directory name could be FAXAPPL or any other name.

4. Give Message Manager users permission to access the network drive or 
directories where the Message Manager software is stored (grant rights 
or permissions as needed).

5. Tell subscribers the software is available and how to access it.  

Sample Subscriber Steps.  After the Message Manager software is copied 
to the server and users are notified, subscribers should follow these general 
steps to install Message Manager:

1. Log into Windows and the network.

2. Access the network directory using the normal procedures for your 
network.  For example, on a NetWare LAN, if your network drive is f: 
and the Message Manager software is on the sys volume, you would 
type map f:=sys:\msg_mgr.

3. From Windows Program Manager, select Run from the File menu.

4. Run the Message Manager Setup program from the network drive.  For 
example, if your network drive is f:, you would type f:\setup.

5. Install the Message Manager software either onto your PC by accepting 
the Setup program's default directory (C:\MSG_MGR) or onto a 
network drive by entering that path instead (for example, 
f:\username\msg_mgr).

6. Select the program group to contain Message Manager icons.  The 
default is INTUITY Message Manager.

7. Select the Continue button to install the software.

8. When the installation is complete, you may view the README file by 
selecting Yes, or return to Windows by selecting No.  The README file 
contains information about interactions with other PC applications.
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To install the optional Message Manager fax software:

1. Log into Windows and the network.

2. Access the network directory for the fax software.  For example, on a 
NetWare LAN, if your network drive is f: and the fax software is on the 
sys volume, you would type map f:=sys:\faxappl.

3. In Windows Program Manager, select Run from the File menu.

4. Run the Message Manager Fax Setup program from the network drive.  
For example, if your network drive is f:, you would type f:\setup.

5. Install to the same directory that contains the rest of your Message 
Manager files.  The default is C:\MSG_MGR.

6. Select the Continue button.  The fax software loads.

7. The INTUITY Message Manager Fax Setup screen then appears.  Enter 
the following information (needed for when you create a fax):

— AUDIX Server ID.  This is the name or IP address of the fax-enabled 
server you use to send or receive messages.  See your LAN or 
system administrator for this information if needed.

— Mailbox Extension.  This is the extension number of the fax-enabled 
mailbox you'll be using to send and receive voice and/or fax 
messages.  This is usually the same number as your regular AUDIX 
mailbox.  Users with secondary fax extensions should not enter that 
number here, but type their regular mailbox extension.

8. Select the OK button to add this information.  If you select Skip, you 
can add the information later using the Fax Options screen.

9. The installation is complete.  To view fax-related information in the fax 
FREADME file, select Yes.  To return to Windows, select No.

Tutorial Installation
The Message Manager Electronic Tutorial introduces new users to the 
Message Manager application through a hands-on approach.  It covers the 
most frequently used features of INTUITY Message Manager in a series of 
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lessons.  You can access the lessons in any order, and you can save your 
place and return to the tutorial later.  Instructions for using the tutorial are 
included with the tutorial and are accessible from every screen.

Installing the Tutorial from Diskette

To install the tutorial from diskette:

1. Turn on your PC and bring up Microsoft Windows (if not already up).

2. Insert Electronic Tutorial software diskette #1 into the disk drive of your 
PC (for example, the a: drive).

3. From Windows Program Manager and select Run from the File menu.

4. Type a:\install in the Command Line and press Enter.

5. When prompted, select the drive and directory in which to store the 
tutorial software.  The default is C:\MMTUTOR.  Select OK to install 
the software.

6. Insert diskette #2 when prompted.  Select the OK button.

7. When the installation is complete, double-click on the Message 
Manager Tutorial icon to start the tutorial.  The tutorial icons always 
appear in the default INTUITY Message Manager program group.

8. Answer any prompts to continue.  When the Main Menu appears, click 
on the About this Tutorial button to find out how to use the tutorial.

Installing the Tutorial from the Server

LAN administrators can distribute copies of the Message Manager tutorial 
from a LAN server instead of having each user install it from diskette.  The 
following steps are to be considered guidelines only.

To run the Message Manager tutorial, a separate copy must be 
installed on each subscriber's PC (installing the tutorial is optional).  
Make sure sufficient space is available (8 Mbytes per copy).

Sample Administrator Steps.  Generally, a LAN administrator should:



Introduction

12 Issue 1   January 1995

1. Have a drive letter mapped to the NetWare server that the Message 
Manager tutorial software is to be copied to.

2. Create a directory for the tutorial  software on the network server.  The 
directory name could be MMTUTOR or any other name.

3. Copy both Message Manager tutorial diskettes into the same directory 
using a standard MS-DOS copy command or Windows File Manager.  
Do not run Install!  

4. Give Message Manager users permission to access the network drive or 
directory where the Message Manager tutorial software is stored (grant 
rights or permissions as needed).

5. Tell subscribers the software is available and how to access it.  

Sample Subscriber Steps.  After the Message Manager tutorial software is 
copied to the server and users are notified, each subscriber should follow 
these general steps to install the tutorial on his or her own machine:

1. Log into Windows and the network.

2. Access the network directory using the normal procedures for your 
network.  For example, on a NetWare LAN, if your network drive is f: 
and the Message Manager tutorial software is on the sys volume, you 
would type map f:=sys:\mmtutor.

3. From Windows Program Manager, select Run from the File menu.

4. Run the tutorial Install program from the network drive.  For example, 
if your network drive is f:, you would type f:\install.

5. Install the Message Manager software onto your PC either by accepting 
the Install program's default directory (C:\MMTUTOR) or by typing 
your own directory name.

We recommend that you do not run the current Release 2.0 
tutorial from a network drive.

6. When prompted to insert diskette #2, select the OK button.
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7. When the installation is complete, double-click on the Message 
Manager Tutorial icon to start the tutorial.  The tutorial icons always 
appear in the default INTUITY Message Manager program group.

The tutorial does not have a standard Windows menu bar.  If you 
have both the Message Manager software and tutorial running at 
the same time and you wish to alternate between them, press 
Ctrl+Esc to activate Task Manager or use Alt+Tab to cycle 
between your active applications.
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2Getting Started

Now that you have installed Message Manager, you are ready to use the 
application.  Like other Windows applications, Message Manager resides 
as an icon on your PC desktop until you are ready to use it.  This chapter 
tells you how to access (log into) Message Manager, and describes some of 
its basic features.

Logging In
To begin using Message Manager, you have to bring up the application, 
then log into the AUDIX server.  This is similar to accessing AUDIX mail 
from your telephone.  To do this:

1. Double-click on the Message Manager icon on your Windows desktop, 
or tab to it and press the Enter key on your keyboard.
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2. In the AUDIX Login Data screen, do the following:

The values shown above are examples only.

3. Select the OK button or press Enter.

If you incorrectly enter the password several times in a row, the 
AUDIX server locks you out of the mailbox to prevent 
unauthorized access.  If this happens, ask your AUDIX system 
administrator to unlock your mailbox.

Message Manager scans your AUDIX mailbox and displays progress 
information.  When it is finished, the Message Manager main screen 
appears, described in the next section.



Learning About Message Manager

Issue 1   January 1995 17

Learning About Message Manager
Message Manager contains elements common to most PC Windows 
applications.  The Message Manager main screen shown below identifies 
the different screen areas. 

SEE ALSO :
For a detailed description of screen elements, see the online help.

As you use Message Manager, you will quickly become comfortable 
working with these elements of the main screen.  You work directly in the 
main screen when you perform the procedures in the next two chapters.
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The main screen toolbar allows one-button access to many of the most 
common Message Manager features.  The toolbar buttons are described 
briefly below.  Procedures using these buttons appear in the following 
chapters.

You can use either your mouse or keyboard to access or work in Message 
Manager screens and dialog boxes.  For example, each of the toolbar 
functions shown above can be accessed from the Activity pulldown menu.

While in a screen or dialog box, you can use your mouse to click on a 
button, or you can tab to that button (an outline identifies the selected 
button) and press the Enter key on your keyboard.

Using Online Help
Although Message Manager is desigmned to be easy to use, you may want 
instructions or clarification as you work in the application.  There are four 
types of online help:

Dynamic help.   Displays information about the screen element or icon the 
cursor is pointing to and shows status information or other system 
messages.  See the main screen figure for this field's location.

Online help.   Select Contents from the Help menu to show the help 
system's table of contents, or select Search for Help On to search for a topic 
by keyword and go directly there.  These Help menu options work like the 
same help options in other Windows applications.
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Screen help.   Available for most screens (windows) and dialog boxes.  
While in a Message Manager screen or dialog box, select the Help button or 
press the F1 function key.

Field help.   Available for each text-entry field, pushbutton, and checkbox.  
Select the field or item, then press Alt-F1 on your keyboard (hold down the 
Alt key, then press F1).

Refer to the online help system for more detailed information than 
this user's guide provides.

Minimizing or Locking Message 
Manager

An advantage of Message Manager is that you can keep it readily available 
throughout the day.  You can minimize it using standard Windows 
techniques, then restore it to retrieve your messages or to create and send 
new messages.  If you receive a new message, the flag on the Message 
Manager mailbox icon goes up to alert you that you have mail.

 For additional security, you can lock Message Manager using the Lock 
feature.  The application is minimized, but you must enter your AUDIX 
password to restore it.  Locking prevents others from reading, listening to, 
or deleting your messages while you're away from your desk (unless you 
give them your password).

To lock Message Manager, select the Lock button on the toolbar or Lock 
from the Activity menu.  The closed door on the mailbox icon means the 
application is locked.  
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While the application is locked or minimized, Message Manager can notify 
you of new messages by raising the flag on the mailbox icon. 

SEE ALSO :
Refer to ‘‘Receiving New Message Notification’’ in Chapter 3 for 
other notification methods Message Manager can use.

When the application is minimized or locked, you can access it using 
standard Windows techniques, such as double-clicking on the mailbox icon 
or using the Restore option.  If locked, Message Manager prompts you for 
your AUDIX password before bringing up the application.

Monitoring the Mailbox
You can leave Message Manager running throughout the day, either 
minimized, locked, or in the foreground or background.  If you do, 
Message Manager checks your mailbox periodically and notifies you if you 
receive new messages.

You may have up to four separate sessions of Message Manager — each for 
a different mailbox — running on a single PC, depending on the resources 
available on that system.  This allows one person, such as a secretary, to 
monitor other people's mailboxes for new messages.  

Check the About Program Manager screen from the Program 
Manager Help menu to make sure you have sufficient resources to 
run additional copies of Message Manager.

When you receive voice mail, Message Manager signals you by the raised 
flag on the application's mailbox-shaped icon.  If you are monitoring more 
than one mailbox, you can see at a glance which subscriber received the 
new message.

Each application you run makes use of the new message notification 
methods that are active for that subscriber's mailbox.  
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Exiting Message Manager
To exit Message Manager, use standard Windows techniques.  For example, 
you can double-click on the control-menu box (shown at left) at the upper 
left of the window or exit through the File menu.  Message Manager erases 
messages marked for deletion when you exit.  See ‘‘Deleting Messages’’ in 
Chapter 3 for details.
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3Handling Incoming Messages

This chapter explains how to access and listen to your incoming messages 
using Message Manager.  It also defines the Message Manager folders and 
describes how to move messages to other folders.

Receiving New Message 
Notification

Message Manager can notify you of new messages whenever it is running.  
Notification occurs if the Message Manager screen is displayed, hidden 
behind another screen, minimized, or locked.

■ Message Manager raises the red flag on its mailbox and shows you a 
letter in the mailbox whenever you have a message in the New folder.  
The mailbox icon appears at the lower left of the main screen.  A raised 
flag also appears on the mailbox icon if Message Manager is minimized 
or locked.

■ You can use the New Message Alerting option to display a pop-up 
window if you receive a new message whenever you are in any 
Windows application.  To activate New Message Alerting, select it from 
the Options menu on the main screen.
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■ By default, Message Manager scans your AUDIX mailbox for new 
messages every few minutes.  If you would like to change how often 
Message Manager checks your mailbox, select a different interval for 
Check For New Messages on the Options menu.

For all the message-notification features described above, the 
AUDIX server must be set up to check for new messages.  Ask 
your AUDIX system administrator about activating new message 
checking on the server if it has been deactivated.

■ Another form of message notification you can use is the Outcalling 
feature, where the AUDIX system calls you if you have new (or new 
priority) messages.  See ‘‘Administering New Message Notification 
(Outcalling)’’ in Chapter 6 for details.

When you discover you have new messages, either log into Message 
Manager as described in Chapter 2, or restore the application from its 
minimized or locked state to display the main screen.  Message Manager 
immediately updates its display to show the new messages.

If the main screen is already displayed, you can check for new messages by 
selecting the New folder.  If a sufficient period of time has passed, Message 
Manager rescans your incoming mailbox and updates the display.  You can 
also select the Refresh option from the Folders menu to update the display 
(for example, if you are expecting a message to arrive).

If you have a message-waiting light on your telephone, it lights up 
whenever you receive new messages, whether or not Message 
Manager is running.  Because Message Manager only checks for new 
messages every few minutes, the message-waiting light on your 
phone may be lit before Message Manager notifies you.  To display 
your new message(s), follow the procedures described above.
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Listening to Messages
Message Manager gives you flexible access to your messages.  When you 
log into Message Manager, the message headers (text summaries) of all 
your new messages are displayed on the main screen in a message list.  You 
can listen to these messages in any order you choose.

SEE ALSO :
You must select a folder from the folder list (for example, the New 
folder), then select a message from the message list shown for that 
folder.  See the following ‘‘Using Folders’’ section for a description of 
messages contained in the different folders.

A typical message list for the New folder might look like this: 

If there are no messages, this message list area is blank and most buttons 
are inactive (indicated by an all-gray version of the button or menu 
option).  If you have no messages, you can send yourself a message using 
the telephone (for example, call yourself and leave a brief message), then 
practice listening to your own message through Message Manager.
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To listen to a message:

1. Select the message header by clicking on it or tabbing to the message 
list and using the up/down arrow keys.

2. Do one of the following to play the message:

— Select the Play button in the audio palette

— Select the Voice button above the message list

— Press the Enter key or F5 function key

— Double-click on the message header.

3. When your telephone rings, pick up the receiver and listen to the 
message.  If you have a speakerphone, just turn on the speaker.

The Audio Connection Indicator at the lower left of the main screen 
changes to a button showing an off-hook receiver when an audio 
connection is active.  If your phone does not ring, select this Hang Up 
button to drop the connection.

Your audio connection number should be the same as the one on 
the telephone at your desk.  (Otherwise, whoever answers the 
phone at the number Message Manager dialed will hear your 
messages.)  To check or change your audio connection number, 
select Audio Connection from the Server menu on the main 
screen.  If needed, type the correct extension and select OK.

4. As a message plays, you can type brief notes about the message in the 
Subject field in the expanded message display (above the message list).  
You can also write a message subject after the message finishes playing, 
or type or change a subject for any selected message in the list.

5. As you listen to the message, you can rewind, fast forward, or stop the 
message using the audio palette buttons shown in the following figure.  
(The touch-tone commands used on your telephone keypad are not 
available when you are in Message Manager.)  
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6. When you are finished listening to the message, you may select another 
message to play.  You do not have to listen to the entire message before 
switching to a different message.

SEE ALSO :
You may respond to incoming messages as described in ‘‘Replying to 
Sender and Forwarding a Message’’ in Chapter 4.

7. When you are finished playing and responding to messages, simply 
hang up your telephone receiver.

You can also select the Audio Connection (or Hang Up) button to 
immediately drop the connection and free up this voice port for use by 
other users.  After your audio connection drops, Message Manager 
must set up a new audio connection for other play or record activities.  

If you do not hang up or if you pause for a certain length of time, 
the audio connection times out and Message Manager 
automatically disconnects the telephone session to free the port 
for use by other subscribers.



Handling Incoming Messages

28 Issue 1   January 1995

Using Folders
Message Manager provides you with flexible access to your messages.  You 
can easily change to different message categories (folders) and quickly look 
at a summary of all the messages in that group.  The message categories 
appear in the folder list on the left side of the main screen.  The number of 
messages in each folder is also shown.

You may select a folder by clicking on it or using the Folder menu.  The 
message list shows the contents of the selected folder.  

The first five folders correspond to message categories in the AUDIX 
telephone interface.  The Personal and Document folders allow you to store 
voice and/or fax messages on your PC or other storage drive.  The 
Wastebasket folder holds messages you have marked for deletion.
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Folder Descriptions

Message Manager folders are described briefly below.  Several folders are 
described in more detail in following chapters.

New.  . This folder contains your new incoming messages.  You may access 
your messages in any order, although you may want to check the Status 
column to see if you have any ! (priority) messages.  Any message in the 
New folder (whether you have accessed it or not) activates your 
notification for new messages (described at the beginning of this chapter), 
except for a login announcement.

Unopened.   This folder contains messages moved from the New folder, 
such as those that you have not yet had time to listen or respond to.

Old.   This folder contains messages moved from the New or Unopened 
folders that you want to keep around for awhile, and previously new 
messages that were recovered from the Wastebasket folder.

Outgoing.   This folder contains status information for messages that you 
created yourself and sent to others.  This is particularly useful for fax 
messages.  See ‘‘Using the Outgoing Folder’’ in Chapter 6 for details.

File Cabinet.  . This folder contains copies of messages you created and 
sent to other subscribers.  You can keep these copies for reference, or 
forward messages if desired to a new list of recipients.  You can save a File 
Cabinet copy when you create a new message (see Chapter 4).

Personal.  . This folder contains messages you have copied from other 
folders.  Because Personal folder messages are stored on a PC or LAN 
storage device, you can keep them as long as you wish for archival or 
reference.  See ‘‘Using the Personal Folder ’’ in Chapter 8 for details.

Document.   This folder contains fax documents saved either when you 
created a new fax or copied the fax part of a message from another folder.  
See ‘‘Using the Document Folder’’ in Chapter 7 for details.
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Wastebasket.. This folder contains messages you have moved from other 
folders and marked for deletion (messages are deleted only on command 
or when you exit Message Manager).  If you wish, you can restore 
(undelete) messages in this folder prior to emptying the wastebasket to free 
up space (messages return to their original folders, except new messages 
which return to the Old folder).

Moving Messages Between Folders

In the AUDIX telephone interface, messages move automatically from one 
category to another (for example, from New to Old) after you access them 
(play a message or its header, or print a fax).  With Message Manager, 
however, messages remain in the whatever folder they are in until you 
move or delete them (see ‘‘Deleting Messages’’ in this chapter).

If you don't move your new messages from the New folder, your new 
message notification methods remain active.  Also, if you move 
messages to the Wastebasket folder but don't empty it, the messages 
appear in their original categories if you access the AUDIX server 
through the telephone interface. 

To move a message, select the message you want to move from the 
message list, then either:

■ Use your mouse to drag it to another folder  or

■ Select the target folder name from the Move menu.  

You can select multiple items by using the Ctrl and Shift keys.  ν

■ To select a range of items, place your cursor on the first item you wish 
to select.  While holding down the Shift key, click on the last item you 
wish to select.  Still holding down the Shift key, move the selected 
messages to the desired folder.

■ To select multiple random items, place your cursor on the first item you 
wish to select.  While holding down the Ctrl key, click on the various 
items you wish to select.  Still holding down the Ctrl key, move the 
selected messages to the desired folder.
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Message Manager restricts movement between folders to those permitted 
in the AUDIX telephone interface.  As you try to move a message, you will 
learn which moves are not allowed.  Refer to the online help for details.

Deleting Messages
You probably want to delete most messages immediately after viewing or 
listening to them.  Messages that you save continue to take up space in 
your mailbox or other storage device until you delete (erase) them.

To help you monitor how full your AUDIX mailbox is, the Mailbox 
Space Indicator at the lower left of the main screen shows how much 
space in your mailbox is being used by messages and greetings.  If 
your mailbox becomes too full, you will be unable to receive new 
incoming messages.

To delete one or more messages, select the message(s) from the message 
list, then do one of the following:

■ Drag the message(s) to the Wastebasket folder

■ Select the Move to Wastebasket button on the toolbar

■ Press the Delete key

■ Select Move to Wastebasket from the Activity menu

■ Select To Wastebasket from the Move menu

Messages remain in the Wastebasket folder until you either empty the 
wastebasket or exit Message Manager.  Until then, you can still listen to a 
message or move it from the Wastebasket back to its previous folder 
(except for new messages, which must be returned to the Old folder). 

If you have the Confirm Deletions option activated on the main 
screen, Message Manager asks you whether you want your messages 
deleted when you exit the application.

To empty the wastebasket, select the Empty Wastebasket button or select 
Empty Wastebasket from the Activity menu.
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Moving messages to the Wastebasket simply marks them for 
deletion.  You must empty the Wastebasket folder to actually erase 
the messages and free up space in your mailbox.  

For all folders except the Personal and Document folder, messages are 
automatically deleted from the AUDIX server after a certain period of time.  
This retention time is set by the system administrator.
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4Creating and Sending Messsages

While Message Manager is a useful tool for viewing or listening to 
messages, it is also a handy way to create voice and fax messages.  If you 
use your AUDIX system primarily to answer calls, you may be interested 
in the advantages of creating and sending messages using a messaging 
system.  Through Message Manager, you can:

■ Convey information when it is more efficient to leave a message rather 
than engage in a telephone conversation

■ Send the same information to two or more individuals

■ Attach a voice or fax message

■ Avoid listening to another subscriber's personal greeting, particularly 
when you know the individual is out of the office

■ Avoid interrupting someone when you only want to give them 
information

Using Message Manager, you can send a message to a single recipient or to 
a stored list of recipient addresses (called a mailing list).  You may also reply 
to the sender of a message or forward a message to other subscribers in an 
AUDIX network.  You can save difficult-to-remember addresses in your 
Personal Phonebook to simplify message addressing.
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Creating a Message
Creating and delivering a message uses the following general process:

■ Creating the message (voice, fax, or both)

■ Addressing the message (to individual recipients, a stored distribution 
list, or a combination of both)

■ Scheduling the message and selecting delivery options (optional)

Message Manager lets you perform these tasks in the order you prefer (for 
example, you can address before creating).  You can also provide message 
subjects for your own reference or for the convenience of other Message 
Manager users who receive your messages.

Fax-enabled subscribers can create either voice, fax, or voice-fax 
messages.  This section covers voice-only messages.  See Chapter 7 
for information on creating and sending fax messages.

Recording a Message

When recording a message you use an audio palette, as you did when you 
listened to a message.    

To record a message:

1. Click on the Create a New Message button or select Create Message 
from the Activity menu.
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2. Do the following in the Message Creation and Transmission screen:

3. If you already have an audio connection — perhaps you just finished 
listening to a message — you can speak your message as soon as you 
hear a beep.  If you do not have an audio connection, your phone will 
ring; answer it and speak your message into the receiver after you hear 
the beep.  

While recording, you can select the Stop button or press the F4 key to 
pause the message.  Press the Play button or press F5 to resume 
recording.  However, Message Manager will time out (hang up the 
audio connection) if you pause too long. 

4. When finished recording, select the Stop button or press the F4 key.  

A beep signals that recording has stopped.  The length of the message 
appears in the Length field, and the Erase button becomes active.

5. If you want to play, re-record, or erase the message, do so using the 
audio palette (see ‘‘Listening to Messages’’ in Chapter 3).

You must rewind a message before you can play it again.

6. Select the OK button to return to the Message Creation and 
Transmission screen.  (If you select Cancel, you exit from the Record 
New Message screen without saving the message).

The length of the message appears below the Voice button on the 
Message Creation and Transmission screen.

Once you have created the message, you must next address it.
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Addressing a Message

You can send a message to individual recipients or send it to multiple 
individuals on a mailing list.  Both addressing methods are described in 
this section.

To address recipients using numbers stored in your Personal 
Phonebook, see ‘‘Selecting a Card’’ in Chapter 5.

Addressing a Single Recipient

To address the message to one or more people individually:

1. Select the Address List box and type the name or number of the 
recipient(s) you wish to receive this message. 

The added recipient name and number appears on the Message Creation 
and Transmission screen.

2. To add more people, repeat step 1.  
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Deleting One or More Entries

To delete one or more addresses from the address list:

1. Select the entry from the address list on the Message Creation and 
Transmission screen.  You can select multiple addresses to delete by 
using the Shift or Control keys.

2. Select the Delete Address button or press the Delete key.

Addressing Using a Mailing List

You can send a message to a group of AUDIX subscribers by using a stored 
mailing list.  To do this, you can use your own mailing list or a public 
mailing list of another subscriber.  Message Manager simplifies this process 
by displaying the mailing list, so you can select the entire list or specific 
entries from the list.

SEE ALSO :
To learn how to create and add entries to a mailing list, see 
‘‘Administering AUDIX Mailing Lists’’ in Chapter 6.

To address the message using a stored mailing list:

1. On the Message Creation and Transmission screen, select the 
down-arrow under the envelopes (AUDIX list) image, or select Add an 
AUDIX List from the Address List menu.

The List Selection screen appears.  If you already have mailing lists, 
they appear in a pulldown list box that contains the ID, number of 
members, and description (if any) for each list.

2. To view the contents of a mailing list, first select the appropriate list 
from the list box, then select the Display Contents of List checkbox.

3. To add list entries from the List Selection screen:
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4. The added name(s) appear in the Message Creation and Transmission 
screen behind the List Selection screen.  If necessary, move the List 
Selection screen to better see the screen behind it.

Adding Entries from a Public Mailing List

You can also add entries from a public list that belongs to another 
subscriber on your system.  To do this:

1. Select the Select Owner button in the List Selection screen, then do the 
following in the AUDIX Directory screen:
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2. In the List Selection screen, either:

— Select the public list you wish to add  or

— Display contents of the desired list and select one or more entries

3. Select the Add button.  The list entries appear in the Message Creation 
and Transmission screen.

4. To add other mailing lists, repeat steps 1 through 3.  Message Manager 
eliminates duplicate entries when it sends the message.

5. Select the Close/Cancel button to return to the Message Creation and 
Transmission screen.

You are now ready to either send the message, or you can select message 
delivery options as described in the next section.

Selecting Options and Scheduling

If you wish, you can mark the message as Priority (for special treatment) or 
Private (to prevent forwarding), save a copy of the message in the File 
Cabinet folder for your reference, or request a printout of information 
related to this message (such as the message type and size, subject, and 
address list).  

To send the message immediately:

1. Select the Send button.

The message is delivered at the earliest opportunity and you return to 
the main screen.

To schedule the message for delivery at a later time or date:

1. Select the Schedule Delivery button from the Message Creation and 
Transmission screen.

The Message Delivery Time screen appears.
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2. Select the desired month, day, and time.  You can select the 
Immediately button if you change your mind and wish to send the 
message now.

3. Select OK to exit the Message Delivery Time screen.  The delivery time 
appears above the Schedule Delivery button on the Message Creation 
and Transmission screen.

4. Select the Send button.  The AUDIX server sends your message.  

You can accidentally schedule message delivery up to a year in 
advance if you schedule before the present time on the current day.  
For example, if at 11:00 a.m. on June 1, you schedule a message for 
10:00 a.m. June 1, the message would not be delivered until June 
1, 10:00 a.m., next year.  To cancel a scheduled delivery time, select 
the Immediately button on the Message Delivery Time screen.

Replying to Sender and 
Forwarding a Message

In addition to creating your own message, you can also reply to the sender 
of a message or forward a message you received or saved to another 
recipient.  You can only reply to the sender of a message if the caller is a 
subscriber in your AUDIX network.

SEE ALSO :
This section covers voice messages only.  See Chapter 7, ‘‘Fax 
Feature’’, for information on fax messages.

To reply to the message sender using automatic addressing:
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1. Select the message.

2. Select the Reply to Sender button or select Reply from the Activity 
menu.

3. Record the message using the Message Creation and Transmission 
screen.  Notice that the sender's name and extension number is already 
in the address list.

4. If you wish, select message delivery options.  For example, you could 
select Include original message to attach the sender's message.

You can also mark the message as Private, Priority, save a copy in your 
File Cabinet, or print information as for any other message.

5. If you wish, you can update the message Subject field.

6. You can add additional addresses using the ‘‘Addressing a Message’’ 
procedure described earlier in this chapter.  Otherwise, there is no need 
to address the message because it is automatically addressed to the 
original message sender.

7. Send the message (or schedule it for later delivery if you wish)

.To forward a message:

1. On the main screen, select the folder that contains the message you 
wish to forward, then select the desired message.

You cannot forward a Private message.

2. Select the Forward Message button, or select Forward from the Activity 
menu.

The Message Creation and Transmission screen appears with the 
Include original message option selected.

3. If you wish, update the message's description in the Subject field.

4. Include at least one recipient in the Address List.  See ‘‘Addressing a 
Message’’ earlier in this chapter for this procedure.

5. To access an Original message, select the Voice cassette or Fax button to 
play and/or view the message you are responding to, or use the 
Original Message menu.
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6. You must include a New Message component for all messages you 
forward (except for File Cabinet messages).  See ‘‘Creating a Message’’ 
earlier in this chapter for details on creating a voice message.  Fax 
procedures are covered in Chapter 7, ‘‘Fax Feature’’
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Personal Phonebook

The Personal Phonebookallows you to store phone numbers, addresses, 
and other information on a PC or other LAN storage device.  You can use 
the Personal Phonebook to save information that is not stored on the 
AUDIX server such as fax numbers, home telephone numbers, AMIS 
two-step addresses, and notes.  You can create one or more Personal 
Phonebook databases to better manage the information you wish to save.  
Each entry in the Personal Phonebook is kept on a card.  

The Personal Phonebook can be used within Message Manager or in 
standalone mode when Message Manager is not running (or if the AUDIX 
server is not available).  The Personal Phonebook allows you to:

■ Create one or more Personal Phonebook databases

■ Add, delete, edit, or print cards in the Personal Phonebook

■ Add subscriber names and numbers from other Message Manager 
screens

■ Pass names and numbers to other Message Manager screens for 
addressing purposes

Adding a Card

A card is a specific entry in the Personal Phonebook database.  You can add 
a new entry to the Personal Phonebook in any of the following ways:

5
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■ Type the information in yourself using the steps in this section.  Use this 
procedure for adding people who are not AUDIX subscribers (such as 
AMIS two-step recipients or fax machines) and cannot be stored in 
AUDIX mailing lists.

■ Edit an existing card and change the required first and/or last name 
fields to create a new entry.  Use this procedure for adding people 
whose information closely matches other entries already in your 
Personal Phonebook database (see the next section).

■ Copy validated subscriber name and mailbox information to the 
Personal Phonebook from another Message Manager screen.  Use this 
procedure if you wish to address messages to AUDIX subscribers using 
your Personal Phonebook database.

To add a new card to the Personal Phonebook:

1. In the Personal Phonebook screen, select the Add Card button or select 
Add Card from the Edit menu.  

The Card Contents fields clear and the cursor is positioned in the Last 
Name field.

NOTE:
Each Personal Phonebook can display a maximum of 600 entries.  If 
this limit has been reached, the Add Card option is grayed out 
(inactive).

2. Enter information in the first two fields.  These fields are required.

Last Name.  Type the last name in any style you like (all caps, initial 
caps, etc.) and tab to the next field.

First Name.  Type the first name in any style you like.  Add a middle 
initial or title (Dr., Mrs., etc.) if you wish (you can use spaces 
between words).
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The following screen shows an example of a new entry being added:

3. Tab to or select the next field where you wish to enter information.

— You can skip any other fields.

— You can cut, copy, and paste information in these fields.

— You can add punctuation.

— In most cases, you do not have to enter the exact information a field 
calls for.  For example, if someone has two fax numbers, you could 
enter their fax-enabled mailbox number in the Business Fax # field 
and their fax machine number in the Home Phone # field or the 
Notes field.

4. When you are finished, select the Save button to add this entry and 
update your Personal Phonebook name list.  Otherwise, select the 
Cancel button to not save the new entry.
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NOTE:
If you enter information in the AUDIX Mailbox #, AUDIX Name, or 
Business Fax # fields, type in the numbers the AUDIX server uses to 
send the message.  For fax numbers, check with your AUDIX system 
administrator in case the server requires you to insert a prefix before 
the fax number.  For example, a fax number of 555-1234 with a prefix 
of 8 must be entered into the Personal Phonebook as 85551234.

Selecting a Card

Once you have added entries to your Personal Phonebook, you can use the 
Name field (at the upper left of the screen) or the name list just below it to 
display specific entries.  Names are listed in alphabetical order by last 
name.  You must select a card to view, edit, print, or delete it.

To select and display a card:

1. Type the last name (or a few letters of it) in the Name field.

2. The first name that begins with those letters is highlighted in the name 
list box.  If this is the entry you want, go to step 4.

3. If there is more than one entry for this letter combination, either enter 
more letters in the Name field until the correct entry is highlighted, or 
click on the desired entry in the name list box.

4. Details about the selected entry appear in the Card Contents fields in 
the center of the screen.  You can now edit, delete, or print this entry.

NOTE:
You can access the Personal Phonebook from the Message Creation 
and Transmission screen or the AUDIX List Administration screen 
(for example, if you are addressing a message or creating a mailing 
list).  You can then select an entry as described above to add it to your 
address list using the Add to Address List option.  Refer to the online 
help for details.
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Editing a Card

You can edit a card in your Personal Phonebook to update information in 
an existing entry, or create a new entry by changing one or both of the 
required name fields, then updating the other fields if needed (for 
example, if you want to add a new entry for someone who uses some of the 
same information as another person who is already in your database).

To edit a card:

1. Select the card you wish to edit in the Personal Phonebook screen, then 
select the Edit Card button.

2. Make any changes to the entry you wish.  See the previous ‘‘Adding a 
Card’’ section for details.

Deleting a Card

Delete a card to permanently remove an entry from your Personal 
Phonebook.  Once you delete an entry, it cannot be restored.

To delete a card:

1. Select the card you wish to delete in the Personal Phonebook screen.

2. Select the Delete Card button.

3. A confirmation box appears.  Select Yes to delete the card, or No to 
return to the card without deleting it.



Personal Phonebook

48 Issue 1   January 1995

Printing a Card

You can print Personal Phonebook cards individually upon request.  Each 
printed report includes the following:

■ The name and location of the Personal Phonebook database that 
contains that card

■ Your AUDIX server ID, subscriber name, extension, and the time and 
date of your print request

■ The complete text of all Card Contents fields for that entry

To print a card:

1. Select the card you wish to print in the Personal Phonebook screen.

2. Select Print Card from the File menu.  The Print screen appears.

3. Select any desired print options, then select OK to print the card or 
Cancel to exit without printing.

Searching for an Entry

Use the Personal Phonebook's search capability to quickly page through 
cards until you locate the entry you're looking for.

NOTE:
Searches are not case sensitive.  You can use wildcards in your search.  
Use a question mark (?) to substitute for a single character, or use an 
asterisk (*) to substitute for multiple letters.

To use the Search option:

1. In the Phonebook select the Search button.  

The Card Contents fields clear and the cursor is positioned in the Last 
Name field.
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2. Enter your search criteria in one or more fields:

— To search by name, type the first few letters of the person whose 
card you wish to locate.

— To search by a different field, select or tab to the desired field and 
type the letters or numbers you wish to search for.

— To search by entries that match two or more fields, type letters or 
numbers in more than one field.  The Personal Phonebook displays 
entries that match what is entered in both (or all) fields.

3. Select the Find button or press Enter to locate the first card that matches 
the name or letters you typed.

4. If more than one entry matches your search criteria, select the Find 
Next Match button to display additional matching entries.

5. When you are finished, select the Exit Search button to end the Search 
activity.

NOTE:
The Search All option under the Edit menu allows you to search for a 
string that may be in any field anywhere in your Personal 
Phonebook.  If you select this option, the Last Name field changes to 
Search String.  Simply enter your string in this field, and Message 
Manager searches all fields in all entries.
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Phonebook Databases

The Personal Phonebook allows you to display different databases (the 
files that contain your entries) depending on how you access it:

■ Within Message Manager.  The default database is in the same 
directory where you installed Message Manager (for example, 
C:\MSG_MGR\PBOOK.MDB).

NOTE:
 When you access the Personal Phonebook through Message 
Manager, it brings up the Personal Phonebook associated with that 
AUDIX server ID and extension number.  If you access more than one 
AUDIX server through Message Manager or have more than one 
extension number, Message Manager can bring up a different 
Personal Phonebook database for each AUDIX server ID and/or 
extension number.

■ In Standalone mode.  The default database is in your root directory (for 
example, C:\PBOOK.MDB).

You can perform the following Personal Phonebook database tasks:

■ Create a Database. Create as many Personal Phonebooks as you need 
to manage your name and number entries.

■ Open a Database.  If you have more than one Personal Phonebook, you 
can easily view, edit, or otherwise access entries stored in a different 
database anytime you are in the Personal Phonebook screen.

■ Import a Database. You can add many entries quickly by importing a 
text file, either one you created or one exported from another Personal 
Phonebook.  However, each database can only display 600 entries.

■ Export a Database.  You can use information in the database in another 
application, prepare a file to import to another Personal Phonebook, or 
quickly print all your Personal Phonebook entries.
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NOTE:
To import a database, you must first either export entries from 
another Personal Phonebook, or create an ASCII text file in the 
correct format (see the online help).  Do not import more than 600 
entries, or the Personal Phonebook cannot display them all.  Entries 
you import will not overwrite existing entries.

Adding Entries to the Phonebook

You can automatically add AUDIX subscribers to your Personal 
Phonebook after you have entered their names on another screen, and the 
AUDIX server has verified that these names and numbers are valid.

You can add entries to the Personal Phonebook from:

■ The AUDIX Directory screen (one entry at a time)

■ The AUDIX List Administration screen (any entries in the address list)

■ The Message Creation and Transmission screen (any entries in the 
address list)

To add one or more entries to the Personal Phonebook:

1. In one of the screens listed above, highlight the entry or entries you 
wish to add, then select the up-arrow button under the Personal 
Phonebook image (cards).

The Personal Phonebook opens, displaying a new card with the last two 
fields already filled in. Because these fields exactly match the way they 
are administered on the AUDIX server, this name and extension are 
“pre-validated”.

NOTE:
If a prefix is required, you must add it yourself to the AUDIX 
Mailbox # field, or the address will not be valid.
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2. Fill out the Last Name and First Name fields (required to add an entry).  
See ‘‘Adding a Card’’ in this chapter for details.

3. Update any other fields where you wish to enter information.

4. When you are finished, select the Save button to add this new entry and 
update the name list in the Personal Phonebook screen.  Select Cancel if 
you do not want to save this card.

5. If you selected more than one entry to add from the address list on the 
other Message Creation and Transmission screen or the AUDIX List 
Administration screen, choose how you wish to respond:

— Select the Add Card button to add the next entry from the address 
list.  Return to step 2.

— Select the Cancel Card button at any time between entries to stop 
adding this list of entries to the Personal Phonebook.

6. When you are finished adding entries, select the Close button to exit the 
Personal Phonebook and return to the Message Manager screen you 
were previously working in.

Standalone Personal Phonebook

The Personal Phonebook can be used even when Message Manager is not 
running.  This is called "standalone" mode.  When you use the Personal 
Phonebook in standalone mode:

■ You cannot access other Message Manager screens, but you can edit, 
delete, and otherwise view or change data in your Personal Phonebook 
database(s) as usual.

■ You can minimize the Personal Phonebook screen so that you can look 
up names without going thorough Message Manager.

■ You can import or export Personal Phonebook databases and edit the 
information within them, even if the AUDIX server is not available.
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Closing the Personal Phonebook

When you close the Personal Phonebook, the database is closed and the 
Personal Phonebook screen disappears.  If you accessed the Personal 
Phonebook from Message Manager, you return to whatever activity you 
were in when you accessed the Personal Phonebook screen.

To close the Personal Phonebook, do one of the following:

■ Select the Close button.

■ Select Exit from the File menu.

■ Use the control box in the upper left corner of the Personal Phonebook 
screen (either double-click on it, or click once and select Close).

The Personal Phonebook accessed through Message Manager closes 
automatically if one of the following occurs:

■ You remain idle with your Personal Phonebook open and the server 
times out.  In this case you return to the Message Manager main screen.

■ You close the screen you called it from (such as the Message Creation 
and Transmission screen or AUDIX List Administration screen).

■ You close Message Manager.

NOTE:
 A Personal Phonebook brought up in standalone mode will not 
automatically close.
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6Other Standard Features

In addition to handling messages, Message Manager gives you several 
other capabilities.  This chapter describes how to create personal greetings, 
use the AUDIX directory, update AUDIX server information, administer 
mailing lists and Outcalling notification, use the Outgoing folder, and print 
various types of Message Manager information.

Creating Personal Greetings
If you don't answer your phone, the AUDIX system can play a personal 
message to callers.  The AUDIX system supports three types of personal 
greetings.  Your AUDIX system administrator determines which type of 
greeting is active for your extension.  The greeting options are:

■ A single greeting.  A personal greeting or the default system greeting.

■ Multiple greetings.  Up to nine personal greetings as well as the option 
of using the default system greeting.

■ Multilingual greetings.  A personal greeting for either the primary and 
secondary language greeting or the default system greeting for one or 
both languages.

You record, activate, or change personal greetings by selecting the Personal 
Greeting Administration button on the toolbar.  Depending on the type of 
greeting administered for your number, the corresponding greeting 
administration screen appears.
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Multiple Personal Greetings

Multiple Personal Greetings allow you to do the following:

■ Record up to nine personal greetings

■ Select the greeting to play based on the type of incoming call

■ Provide descriptive names for greetings

To record and assign a personal greeting:

1. Click on the Administer Personal Greetings button or select Greetings 
from the Activity menu.

The Multiple Personal Greetings screen appears.
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2. Select the Record Greeting button for the desired greeting, or tab to the 
appropriate greeting cassette and press Enter.  

You cannot change the default system greeting.  Only the AUDIX 
system administrator can do this.

The Personal Greeting screen for the selected greeting appears.

3. If no personal greeting is recorded, Message Manager begins recording.  
Otherwise, you can play and/or re-record as desired.

SEE ALSO :
For details on the audio palette buttons, see ‘‘Recording a Message’’ 
in Chapter 4.

4. If you type a greeting description on this screen, you can use this 
greeting "label" to activate or delete greetings.  Select OK or Cancel to 
return to the Personal Greeting Administration screen.
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5. You can set up Message Manager to play a different personal greeting 
based on the type of incoming call received.  To change your call 
response type(s), choose a different selection in the upper left corner of 
the Personal Greeting Administration screen.

Several combinations are available as shown in the figure.  
(Busy/No-Answer call types are not available with MERLIN LEGEND 
Communication Systems.)

6. Assign (activate) a greeting by dragging the greeting's label to the label 
of the response type (see the Personal Greeting Administration screen 
figure), or by typing the greeting number in the response type field (to 
the right of the response type description field).  

7. To delete a greeting, drag the greeting label to the Wastebasket or tab to 
the greeting's cassette and press the Delete key.

You cannot restore a deleted greeting from the wastebasket.

8. When you are finished, select OK to return to the main screen.

Multilingual Greetings

The Multilingual Greeting feature allows you to record a personal greeting 
for either your primary or secondary language, or to activate the system 
default greeting for either or both.

You record, delete, or type a description for a multilingual personal 
greeting the same way you do for multiple personal greetings (see the 
previous section).  If you record a personal greeting, be sure to tell callers 
(in the alternate language, if possible) how to access the alternate language 
by pressing *1.  In the example above, the subscriber has recorded a 
personal greeting for the primary language, but left the default system 
greeting active for the secondary language.
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Single Greeting

If you have neither Multiple Personal Greetings or Multilingual Greetings, 
a smaller version of the Personal Greeting Administration screen appears.  
You can use it to record one personal greeting that will be heard by all 
callers.  To return to using the system default greeting, delete your personal 
greeting (see the previous section for details on these activities).

Using the AUDIX Directory 
Message Manager has a directory feature similar to the AUDIX telephone 
interface's Names and Numbers directory (**N).  You can use this feature 
to search for other subscribers on your AUDIX system by specifying a 
name (typically last name first) or extension number.

To use the AUDIX subscriber directory:

On the main screen, select the AUDIX Directory button or select Directory 
from the Activity menu, then do the following in the AUDIX Directory 
screen.
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You can only transfer based on the transfer restrictions of your 
local switching system.  The Call button does not appear if the 
extension is not on your AUDIX network, or if your system is not 
administered for the Transfer Out of AUDIX feature.  

Changing Server Data
You can display, update, or change the following AUDIX server features 
using the Server menu on the main screen.  Features you change in 
Message Manager are also updated on the AUDIX server.ν

■ AUDIX Password.  Brings up a change password screen.  You must first 
enter your old password, then confirm your new password by entering 
it twice.

■ Play/Record Name.  Brings up an audio palette for you to play or 
record your subscriber name.  The AUDIX server plays your name in 
several of its system announcements.

■ Covering Extension.  Allows you to change your covering extension.  If 
this option is enabled for your extension, you can change the extension 
where incoming calls are forwarded if a caller presses 0 during your 
personal greeting.

■ Audio Connection.  Brings up the Enter Audio Connection Number 
screen, allowing you to enter a different extension or telephone number 
at which you want Message Manager to call you.

Administering AUDIX Mailing Lists
You can use Message Manager to distribute a message to a stored list of 
subscribers.  Creating and using a mailing list allows you to quickly send 
voice mail to people that you communicate with on a regular basis.  

Besides sending mail to everyone on the mailing list,  you can also use the 
list as an addressing shortcut.  Instead of adding recipients individually, 
you can display the contents of  the list and select the individuals you wish 
from the list.  Then send the message the way you normally would.
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You can also view and use public (not private) mailing lists belonging to 
other subscribers, such as the department secretary.  Because of its visual 
interface and the ability to print list information, Message Manager 
simplifies creating, editing, and maintaining mailing lists. 

To create a new mailing list:

1. Select the AUDIX List Administration button or select AUDIX List 
from the Activity menu.  The AUDIX List Administration screen 
appears (see the following figure).

2. Select the Create a New List button.  When the Create New List screen 
appears, do the following: NOTE:

You can also access the Create New List screen if you select the 
up-arrow under the envelopes (AUDIX list) image on the 
Message Creation and Transmission screen (or Add Addresses as 
an AUDIX List under the Address List menu).  In this case, the 
addresses are already entered; you just create a list to save them.

3. Message Manager returns you to the AUDIX List Administration 
screen, with the List ID and name in the List Selection box.  The list 
member count is zero.
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4. You can add, delete, or change members of an open list the same way as 
you add individual recipients or mailing list members to an address list 
on the Message Creation and Transmission screen.

SEE ALSO :
See ‘‘Addressing a Message’’ in Chapter 4 for details on adding 
individual recipients or members of another mailing list (either your 
own or another subscriber's) to an address list.

5. When finished, you can save the list by selecting one of the following:

— Save Current List to save the working list  or

— Save As to save the list using a different list ID.

Selecting the Save As option brings up a screen similar to the 
Create New List screen.  You can use the Save As option to add 
descriptions for mailing lists that were created without one (for 
example, through the telephone interface).

6. To return to the main screen, select Close.

Administering New Message 
Notification (Outcalling)

Using Message Manager you can have the AUDIX system call you to notify 
you of new messages.  You can use this feature to have the AUDIX system 
call an off-premises number or notify a pager.
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To administer Outcalling notification:

1. Select the Outcalling Notification button, or select Notification from 
the Activity menu and do the following in the New Message 
Notification screen:

Because access to Outcalling Notification is controlled by your system 
administrator,  this feature is grayed out (inactive) if you are not 
administered to have it.  Your choices for Outcalling numbers are also 
subject to administrator restrictions.  

Message Manager calls your telephone to make an audio 
connection using the same ports that are used for the Outcalling 
feature.  If you find you aren't receiving your Outcalling 
notification in a timely manner, ask your system administrator 
about increasing the number of ports that are used for Outcalling.
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Using the Outgoing Folder
The Outgoing folder shows the status of messages that you have created 
(or forwarded) and sent to others.  You can check the Outgoing folder 
whenever you want to make sure a message was accessed by the intended 
recipient(s).  The Outgoing folder is especially useful to make sure fax 
messages were successfully delivered.

If a message cannot be delivered (fails), you receive an 
AUDIX-generated message in your New folder informing you of the 
failure.  Check your Outgoing folder to find out which message 
failed and possibly send it again.  The message list shows a status of 
F (failed) for the entire message, even if only one recipient did not 
receive it.

To display the Outgoing folder, select it from the Folder list on the main 
screen as described in ‘‘Using Folders’’ in Chapter 3.  It may take Message 
Manager about 1 second to retrieve information on each recipient.  In the 
following example, three messages were sent to five recipients, so it might 
take 5 seconds to update the display.
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Once your Outgoing folder is selected, you can access the Message 
Delivery Report to find out detailed status information about the selected 
message.  You may wish to display the Message Delivery Report when:

■ A message in the message list shows a status of F (failed), and you want 
to correct the problem and send the message again.

■ A message in the message list was sent to multiple addresses, and you 
want to check which recipients have received or accessed the message.

To access the Message Delivery Report, select a message from the message 
list, then either double-click or press Enter.  Refer to the online help for 
details on using the Message Delivery Report.

To increase the speed at which the Outgoing folder display is 
updated, you can delete message status notifications you do not 
need.  You can either remove all notifications for a message by 
deleting the message from the message list, or you can remove some 
of the notifications by status (such as removing all delivered and/or 
accessed notifications) through the Message Delivery Report.

Printing Information
Message Manager allows you to print the following information, either 
from the Print button on various screens, or through Print options on the 
File menu in various screens.

■ Fax Messages.  You can print fax documents either through the Fax 
Viewer (see Chapter 7, ‘‘Fax Feature’’) or on the main screen.  You can 
print faxes either to a LAN printer or to a fax machine.
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■ Message Reports.  You can print reports for any selected message in the 
message list, for all messages in a folder, or for all messages in all 
folders using the Print option under the File menu on the main screen.  
Information includes the message sender or recipient, subject, status, 
time, date, and message length.

— You can print reports for messages you send using the Print option 
on the Message Creation and Transmission screen.

— You can print status reports for messages you sent through the 
Outgoing folder through the Message Delivery Report.

■ Mailing List Information.  You can print the titles and/or contents of 
your stored mailing lists (or other subscribers' public lists) using the 
Print option on the AUDIX List Administration screen.

■ Outcalling Information.  You can print your Outcalling number, 
schedule, and options for reference using the Print button on the New 
Message Notification (Outcalling) screen.

■ Personal Greeting Information.  You can print your personal 
greeting(s) response types, length, description, and status using the 
Print button on the Personal Greetings Administration screen.

■ Personal Phonebook Entries.  You can print your Personal Phonebook 
cards individually on request  Each report includes the name and 
location of the database that contains the entry and the complete text of 
all fields for that card.
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7Fax Feature

The Intuity Message Manager fax application lets you send, receive, and 
create fax and/or voice-fax messages.  You can also direct faxes to LAN 
printers, fax-enabled mailboxes, and fax machines.

You can send or forward a fax to an address within your system (and 
append a voice message to the fax if you choose), or you may elect to send 
or forward only the fax to an address outside your system. 

This chapter covers receiving, viewing, printing, creating, sending, and 
optionally storing fax messages.

Voice-fax messaging provides four key capabilities:

■ Mobility.  You can access your voice, fax, and voice-fax messages from 
anywhere.  You can retrieve a fax from your mailbox and have it printed 
anywhere a fax machine is available.

■ Convenience.  You can retrieve your voice, fax, and voice-fax messages 
from your desktop, from your home office, from anywhere in the 
country, or from across the world.

■ Privacy.  You control when and where a voice or fax message is 
retrieved, and where a fax is printed, so you can be sure that it ends up 
in your hands only.

■ Security.  Only you can retrieve your voice, fax, and voice-fax messages 
using your password-protected login to access your mailbox.
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An average fax message at standard resolution consists of 3 pages 
and takes up 1 minute of storage or 120 Kbytes on disk.  This 
equates to 20 seconds of storage per page in your mailbox or 
about 40K per page on disk (faxes at fine resolution take up twice 
this amount).  A 5-page fax at standard resolution would 
therefore produce a 200K file on disk.  However, the size of fax 
messages can vary greatly depending on their contents.

The biggest fax you can send or receive is about 60 pages at standard 
resolution assuming you have a 2400-second mailbox with an average 
number of messages and greetings in it.  You may not be able to forward 
large fax messages or print them to a fax machine.

Receiving and Viewing a Fax
Use the Fax Viewer to display (and optionally print or export) any fax 
messages you send or receive.  You can display the Fax Viewer from the 
main screen or the Message Creation and Transmission screen.

To access the Fax Viewer from the main screen:

1. Select a message in the message list that contains a fax icon.

2. Double-click on the highlighted message or select the Fax button from 
the expanded message display (above the message list).

The fax message then appears in the Fax Viewer window.  See the figure on 
the following page.

If you are viewing a fax using a remote-access connection (over a 
modem), it may take 30 or more seconds for the AUDIX server to 
transmit each page of the fax to your local PC running Message 
Manager.  For example, a 6-page fax could take 3 or more minutes to 
load (depending on the speed of your modem).

To access the Fax Viewer from the Message Creation and Transmission 
screen (for example, if you are responding to an incoming message), 
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simply select the Fax button for the message you wish to display, or use the 
New Message or Original Message menu options.

You can change the size of the viewer window to see more of your fax 
document, either by selecting the Maximize button at the upper right of the 
title bar, using the resizing handles at the corners of the screen, or using the 
Size of Viewer menu.  Changes you make to size or magnification are 
saved for the next time you access the Fax Viewer.  

A few buttons are available at the bottom of the screen for common 
functions.  Additional fax functions can be accessed through the menus or 
hot key shortcuts (see Appendix A, ‘‘Hot Keys’’).

You can also use the audio palette function keys to play or record the 
voice part of a voice-fax message, even if the viewer is at full size.  
See ‘‘Listening to Messages’’ in Chapter 3 for details.
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When you are finished using the Fax Viewer, do one of the following:

■ Select the Close button (or Close from the File menu) to exit the viewer.  
The Size of Viewer and Magnification settings are saved and will be 
active the next time you access the viewer.

Fax Viewer Options

Viewing a different page ■ Type the desired page number in the Page 
field and press Enter, or use the >> (page 
forward) or << (page back) buttons at the 
bottom of the screen.

■ Use the Page menu options for Previous 
Page or Next Page at the top of the screen.

Adjusting the magnification ■ You can zoom in (make the image larger) or 
zoom out (make the image smaller) using 
either the slidebar at the bottom of the screen 
or the Zoom In or the Zoom Out controls or 
menu options.  You can also change the 
image to be 2x, 4x, or 20x its original size, or 
return it to the original size using the menu 
or slidebar.

Changing the contrast ■ Use contrast Lower to lighten the text

■ Use contrast Higher to darken the text

Rotating the fax image ■ Use the Rotation menu to turn the fax image 
a quarter turn to the left or right or flip it 
upside down.  The different options rotate 
the fax image based on the way it was 
received, not what may be currently showing 
in the viewer.  To return the fax to its original 
orientation, select No Rotation.
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■ Select Cancel to exit the viewer and save the settings as above.  
However, the fax you just viewed is no longer attached to your new 
message (this option only works when you access the viewer from the 
Message Creation and Transmission screen).

Printing a Fax
Printing a fax means generating a paper copy of the fax.  You can print 
faxes either to a local or network (LAN) printer, or to a fax machine by 
sending the fax through the AUDIX server.

Message Manager can print faxes to some print drivers faster than 
others.  For example, printing to a dot-matrix printer will always be 
slow.  Buffered printers work faster than nonbuffered printers.

Printing a Fax on a Local or Network Printer

To print a fax on a local or network printer:

1. Either select the fax you wish to print on the main screen, or display the 
fax in the Fax Viewer.

2. From the File menu, select Print Fax to Printer.  (On the main screen you 
must first select Print, then the Print Fax to Printer option). 

3. When the Print screen appears, do the following:

— Printer.  Use the Setup button to select a printer.

— Copies.  Enter how many copies you want printed.

— Pages.  Enter the pages you want to print.

4. Select the OK button to print the fax.
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Printing a Fax on a Fax Machine

To print a fax on a fax machine:

1. Either select the fax you wish to print on the main screen, or display the 
fax in the Fax Viewer.

2. From the File menu, select Print Fax to Fax Machine.  (On the main 
screen you must first select Print, then the Fax to Fax Machine option).

3. When the Enter Fax Machine screen appears, type the number of the fax 
machine where you want the fax to print.  

SEE ALSO :
If your AUDIX system administrator has specified a prefix for 
sending fax messages to a fax endpoint (such as a fax machine or PC 
fax modem), you must type these numbers before the extension 
number.  See ‘‘Setting Your Fax Options’’ for details on entering fax 
machine numbers and prefixes.

4. Select the OK button to print the fax.

Using the Document Folder
The Document folder is used to store copies of faxes that you have created 
or received.  You can include these saved faxes in new messages you create 
or forward to others.

Document folder fax documents can be stored on a PC, diskette, or LAN 
storage device until you specifically choose to delete them (they are not 
automatically erased after a period of time like messages stored on the 
AUDIX server).  You can have more than one Document folder.
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You can do the following in the Document folder:

■ Save a new fax you created in your Document folder.

SEE ALSO :
See the ‘‘Sending or Saving a Fax’’ section for more details.ν

■ Restore a Document folder message to the AUDIX server.

■ Save a fax you received from others by selecting the desired message(s) 
from the message list, then copying the fax component(s) to the 
Document folder using any move message method you wish.

You can save fax-only messages or the fax part of voice-fax 
messages in a Document folder even if your Personal folder is not 
active.

■ View faxes saved in the Document folder.

■ Send a fax saved in the Document folder as part of a new message.

To better manage your stored fax messages, you may create different 
directories based on the message content or the date messages were stored.  
The directory may be named whatever you like, but the subdirectory must 
be given the name Document or Message Manager will not allow you to 
select it.  For example, if you plan to store fax messages by date, you might 
create a directory labeled March and a subdirectory labeled Document to 
actually hold your fax messages.

SEE ALSO :
See the online help for more details on selecting different document 
folder directories.
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Setting Your Fax Options
Before you create a fax, you should view your fax options through Message 
Manager to make sure your system is ready to support fax messaging.  You 
can customize these options to make fax creation a simple, one-step 
process.

■ View or change fax options for a fax-enabled mailbox

■ Find out if your AUDIX server supports fax messaging

■ Update fax information for your copy of Message Manager

To view or change your fax options:

1. On the main screen, select Fax from the Options menu.

2. Keep the following guidelines in mind when setting your Default Fax 
Print Number:

— Internal fax numbers.  If the fax machine resides on your local 
system, type the fax print prefix (if administered) followed by an 
extension number.  For example, you might type a prefix of 3 or f 
(for "fax") followed by an extension of 1234 (if 4-digit extensions are 
used on your system). 
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— External fax numbers.  If the fax machine resides outside of your 
local system, type the prefix (if needed) followed by the complete 
telephone number.  For example, you might type a prefix of 201 (for 
the area code) followed by a phone number of 5551234.

See your system administrator for dialing instructions on using 
outside lines and long distance numbers.

Sending a Fax
Before you can send a new fax message or store a fax in your Document 
folder (to send later), you must first create a fax.

Creating a New Fax 

Before you start:

■ Set any fax print driver options through the Windows Control Panel.  
Select Printers, highlight the AT&T MM Fax Print Driver, then select 
Setup to change your resolution (standard or fine), page size, or 
orientation.  Note that fine-resolution faxes use twice the disk space.

■ If you intend to save the fax in your Document folder, bring up Message 
Manager and select the Document folder you wish to store your faxes 
in.

You cannot change Document folder directories after the Message 
Creation and Transmission screen appears; you must select the 
correct Document directory in advance.

■ You may leave Message Manager running in the background or 
minimized so you do not have to log in again after you create the fax.
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To create a new fax:

1. Create document you wish to send as a fax using any Windows 
application (such as Microsoft Word).  

2. Select Print Setup from the File menu, then select the AT&T MM Fax 
Print Driver as your printing device.

3. Return to your application.  Select Print from the toolbar or from the 
File menu.

See the note on fax message size at the beginning of this chapter.

4. When the printing is complete, one of the following occurs:

— If you previously logged into Message Manager, the Message 
Creation and Transmission screen appears.

— If Message Manager is not running, you must first log in.  Message 
Manager then displays the Message Creation and Transmission 
screen.

You can now either send or save this fax.  Continue with the next section.

Sending or Saving a Fax

Once you create a fax, you have the option of saving it in the currently 
selected Document folder, sending it immediately to one or more 
recipients, or both.

To send a fax you have just created:

1. Select the Fax button if you wish to view your new fax.

When the Message Creation and Transmission screen appears, the Fax 
button in the New Message area is already loaded with your new fax.

2. Label your fax message by entering a brief description in the Subject 
field.  This is especially important if you plan to save a copy of your fax 
in the Document folder.
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3. You can attach a cover page by selecting the Fax Cover Page button.  A 
cover page is recommended whenever the destination is a fax machine.  
See ‘‘Creating a Cover Page’’ in this chapter for details.

4. Enter the address(es) of the recipient(s) you wish to receive this fax 
message.

If your AUDIX system administrator has specified a prefix for 
sending fax messages to a fax endpoint (such as a fax machine or 
PC fax modem, but not a LAN printer), you must type these 
numbers before the extension number.  For example, if the prefix 
is 3 or f (for "fax"), and you wish to send it to a local fax machine 
at extension 1234, you would type 3 followed by 1234.  If you use 
a print prefix and still cannot send a fax to a fax endpoint, contact 
your system administrator.

5. You can optionally save the fax for future use or reference by selecting 
the Save New Fax button in the New Message area of the screen.

The fax is now saved in the currently selected Document folder.

6. If you wish, select delivery options or message delivery time.  See 
‘‘Selecting Options and Scheduling’’ in Chapter 4.

7. Send the fax by selecting the Send button.  When finished, Message 
Manager returns you to your application.

Message Manager returns to whatever state it was in before you 
created the fax.  For example, if Message Manager was running 
minimized, it returns to its minimized state.  If you had to log into 
Message Manager to create your fax, Message Manager logs off 
after the fax is created (and optionally saved or sent).

Sending a Stored Fax

You can send a fax that you have previously saved in your Document 
folder as a new message or in response to a message you received. 

To include a stored fax in a new message:
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1. On the main screen, select the correct Document folder.

2. Select the desired fax from the message list.

3. Select the Forward Message button on the toolbar, or select Forward 
from the Activity menu.

The Message Creation and Transmission screen appears with the fax 
already loaded in the New Message area.

4. Select the Fax button if you wish to view your fax.

5. To address and send this fax, see ‘‘Creating a Message’’ in Chapter 4.

Creating a Cover Page
You can include a fax cover page for any new fax or voice-fax messages 
you send or respond to.  A fax cover page is especially useful:ν

■ Whenever you intend to send a fax message directly to a recipient's fax 
machine.

■ If you wish to send a brief, one-page fax message that consists only of 
the fax cover page and whatever information you choose to include in 
the Notes field.

To view or customize a fax cover page:

1. On the Message Creation and Transmission screen, select the Fax Cover 
Page button.

The Fax Cover Page screen appears.
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2. Normally the names of all recipients in the address list on the Message 
Creation and Transmission screen are included.  If you do not want to 
include the list of recipients on your cover page, clear the Show 
recipient list on cover page checkbox.

If you included a fax cover page earlier in this activity but no 
longer wish to send it, simply select the Fax Cover Page button 
and select Cancel on the Fax Cover Page screen.

Exporting a Fax
You can save any fax image displayed in your Fax Viewer as a bitmap 
(.BMP) or TIFF (.TIF) file on your PC or another LAN storage device for 
future use or reference.  For example, you can try using your own Optical 
Character Recognition (OCR) software on an exported file if you wish to 
turn it back into a text file.

SEE ALSO :
Refer to the online help for details on exporting faxes and managing 
fax files on disk.
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8More About Message Manager

This chapter describes the Personal folder, interactions with the AUDIX 
server and telephone interface, and the remote access feature.

Using the Personal Folder
The system administrator decides how long messages are retained in your 
mailbox.  If you have a critical message that you would like to access later 
or keep as a permanent record, you can store the message directly on your 
PC or other storage device by moving the message into your Personal 
folder.  You must have sufficient storage space on your personal computer 
or network drive to hold voice and/or fax messages.  

Each second of recorded speech takes up about 2,000 bytes (2K) of 
storage space (for example, a 5-second message would produce a 10K 
Personal folder file).  A standard 3.5-inch 1.44-Mbyte diskette holds 
about 12 minutes of messages.  Message headers and other text-only 
messages take up about 1K of storage.  See Chapter 7, ‘‘Fax Feature’’, 
for size estimates for fax documents.

To place a message in the Personal folder, simply copy it to that folder 
using one of the ‘‘Moving Messages Between Folders’’ techniques 
described in Chapter 3.  Messages are copied, not moved, to a Personal 
folder.  For example, dragging a message from the New folder to the 
Personal folder leaves the original in the New folder and a copy in the 
Personal folder.
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The Voice Over LAN feature must be activated on your AUDIX 
server for you to copy voice messages to your PC.  If this feature is 
not active, you can only copy fax-only messages or the fax part of 
voice-fax messages to your Personal folder.

You can forward a message to another AUDIX subscriber by first copying 
the message by dragging it to the New folder or using the Activity menu.  
The copy becomes a new incoming message, which you can then forward 
as described in ‘‘Replying to Sender and Forwarding a Message’’ in 
Chapter 4.  You cannot forward Personal folder messages that were 
originally marked Private.

If you store many files in your Personal folder, you may create several 
Personal folder directories, such as one for each month or each client.  First 
create the new directory using Windows or MS-DOS.  Next, choose Select 
Personal Folder from the File menu, then select the new folder name (you 
cannot create a new folder directory from this screen).

Archiving a Message onto Diskette

You can use Message Manager to copy a message file to a diskette.  If you 
want to save a message that is currently in one of your Message Manager 
folders, do the following:

1. Insert a diskette in your disk drive.

2. Use the Select Personal Folder option under the File menu to select your 
disk drive and directory (for example, a:\mm_oct95).

3. Using the mouse or the Move menu, copy each message you want to 
store to the Personal folder.

4. Change the Personal folder back to the directory you had initially 
designated for your Personal folder (for example, on your hard drive).

If you want to store to diskette a file that is already stored in the 
Personal folder, you must first copy it back to New folder by 
dragging it or using the Activity menu.  This transfers the file 
from your PC or LAN storage device to the AUDIX server (you 
receive a new message).  You can then copy the restored message 
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to the Personal folder you are archiving and store it on diskette as 
described above.

Listening to an Archived Message

You can play or view messages stored in a Personal folder through 
Message Manager.  On the main screen, simply select the Personal folder 
directory, then play the message as described in ‘‘Listening to Messages’’ in 
Chapter 3, or display a fax as described in Chapter 7, ‘‘Fax Feature’’.  If you 
have more than one Personal folder directory (or if you have stored 
Personal folder messages on diskette), you may first need to select the 
correct Personal folder from the File menu.

You may notice a slight delay when you play Personal folder messages.  
This is because the message is actually copied from your PC to the AUDIX 
server in order for you to play it.  However, you cannot listen to Personal 
folder messages through the AUDIX telephone interface unless you first 
copy them back to the New folder using the Activity menu.

Working With the AUDIX Server
While it appears that Message Manager is constantly connected to the 
AUDIX server, this is not so.  Message Manager is only actively connected 
(logged in) to the AUDIX server when you interact with it (for example, 
when you play or record a message).  The rest of the time Message 
Manager simply checks your mailbox periodically for new messages.

The interaction between the AUDIX server and Message Manager is 
apparent, for example, when you open a new folder.  It may take a few 
seconds for the message headers to appear (depending on the number of 
messages).  This is because Message Manager is logging into your AUDIX 
mailbox and scanning your messages there.  

If you listen to a new message through Message Manager and leave it in 
the New folder, the message also remains in the new category if you access 
the AUDIX system through the telephone interface, and your new message 
notification methods remain active.
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During a Message Manager session, you will "time out" of the AUDIX 
server whenever you pause for a predetermined length of time.  First, 
because the AUDIX server has a limited number of voice ports, it hangs up 
your audio connection if you are not actively using it, allowing other 
subscribers to use that port.  

Also, you may be disconnected from ("logged off") the AUDIX server if 
you are not interacting with it in some way.  You can safely ignore most 
server logoff messages.  However, if you are in the middle of some activity 
(such as creating a message or editing an address list), you must interact 
with the server periodically or you could lose your work in progress.

Even if you see a logoff message on your dynamic help line, Message 
Manager will still notify you about new messages (if the Check for 
New Messages feature is active on the AUDIX server).

Working with the Telephone 
Interface

If Message Manager is logged into the AUDIX server, you cannot log into 
your mailbox through the telephone interface.  However, if you leave 
Message Manager idle, it soon logs off the server automatically.  If you 
minimize or lock Message Manager, the server connection is dropped 
immediately.  When this happens, you can access your mailbox through 
the telephone interface and listen to or delete messages as usual.  

If you left the Message Manager screen up and later logged in through the 
telephone interface, you may see a discrepancy between the main screen 
display and the actual contents of your folders (for example, you may have 
moved all your new messages to the Old category through the telephone 
interface).  Simply refresh your screen to update the display by selecting 
the desired folder or using the Refresh option from the Folder menu.  If 
you relogin or restore Message Manager after it was minimized or locked, 
the display is updated automatically.
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Relogging Into Message Manager
The AUDIX server allows only one login to your mailbox to be active at a 
time.  For example, you can either log into Message Manager at your PC or 
access the AUDIX system through the telephone interface, but not both.  

However, Message Manager allows you to relogin through your PC if it 
detects an active login (for example, a co-worker monitoring your mailbox, 
or an active telephone session).  At your request, Message Manager can 
drop an existing PC connection in favor of your new login request.  If you 
have a telephone interface connection active, you must hang up that 
connection to the AUDIX system yourself.

If Message Manager reports an active login when there shouldn't be 
one, contact your system administrator to report possible tampering.

Remote Access
Normally you run Message Manager on a PC that is directly connected to 
your Local Area Network (LAN).  However, you can remotely access 
Message Manager using a modem if you are off-premises or cannot 
otherwise directly connect to the LAN.

Remote access to Message Manager uses customer-provided 
products and setups.  AT&T does not endorse any particular product, 
or guarantee that remote access will work in any given situation.

The following figure illustrates the remote access feature.
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The following are recommended or suggested to support remote access:

■ The same PC, LAN, and AUDIX server requirements listed in 
‘‘Hardware and Software Requirements’’ in Chapter 1.

■ PC networking software that supports PPP or SLIP protocol.

■ An internal or external PC modem (a minimum baud rate of 9600 bps is 
required, but a modem that supports 14,400 bps or faster is 
recommended).

The DOS msd command should identify an existing serial port as 
type 16650.  If a new serial port is needed for an external modem, 
the card should use a 16650 USART.
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■ At least one remote access port that provides PPP or SLIP entry onto the 
network (this could be a serial port on another PC with a direct network 
tap, or a dedicated terminal server that provides many ports).

■ A switching system connected to the AUDIX server that allows access 
to the public telephone network.

■ A remote location that ideally provides two telephone lines:

— One line (to the modem) that provides the data connection (required 
to access or view messages or data)

— A second line (to a telephone) that allows you to record or play 
messages or greetings (required for full functionality)

The second (voice) line must allow direct inward dialing (no 
human attendants between the calling and called parties).  This is 
not usually available, for example, in most hotels.

To access Message Manager using a remote connection:

1. Establish a network connection as required by your networking 
software, and log into the network.

2. Once your PPP or SLIP session is running, log into Message Manager as 
usual, but be sure to change your Audio Connection Number to dial the 
number of the telephone at your remote location.  You may need to 
include an access code (such as 9) to dial an outside line.

If you leave your audio connection number set to your office 
extension and the AUDIX system answers the call, it will record 
any message you attempt to play.

3. Use Message Manager as usual.  All features are available, but the 
response time will be slower than you are used to, especially if you are 
using a slower-speed modem.

4. When you are finished, you may wish to terminate your session and log 
off, especially if there is a charge for maintaining the line or if limited 
ports are available for accessing the network.  Otherwise, you can leave 
Message Manager active to check for incoming messages.
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9Troubleshooting

While working in Message Manager, you will occasionally see warning 
screens or other error messages.  In most cases these contain an 
easy-to-understand explanation of a problem.  For example, if you record a 
new message and then press Cancel in the Message Creation and 
Transmission screen, the system warns you that you did not send a 
message and asks you if you really want to exit the activity.

This troubleshooting  chapter describes what to do when you have a more 
severe problem (Message Manager may not be working at all).  You must 
follow a "fault isolation" process to identify the source of the problem.  
Difficulties could come from several sources: 

■ Message Manager

■ Your PC

■ The Local Area Network (LAN)

■ The telephone system (switch)

■ The AUDIX server

You must check each of these five areas to determine what is causing the 
problem.  Depending on where the problem lies, you may have to refer the 
problem to your AUDIX system administrator or the LAN administrator.  
Keep in mind that more than one factor may contribute to the problem 
you're experiencing.
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AT&T Professional Services
AT&T's Professional Services provides varying degrees of consultative and 
implementation assistance for your LAN/PC and Telecommunication 
Administrators.  As a customer you may choose to select one of the 
professional service offers that provide you with a consultant at your 
business location.  You may also choose to work with a consultant remotely 
(over the phone).  For details and pricing information on these offers, 
please contact your AT&T Account Team.

Problem Isolation

As long as the Message Manager application is up and running, it is able to 
display error messages about user or system problems.  For example:

■ If you do something incorrectly or forget an important step in a 
procedure, Message Manager brings up a message box stating the 
problem.  Refer to the online help for that activity if you don't 
understand why you got an error message.

■ If Message Manager can't communicate with the AUDIX server, it 
brings up the Message Manager Error screen.  If the screen contains 
specific communications or problem information, copy down the error 
information and report it to the appropriate system administrator (the 
LAN or AUDIX person).

Check the Message Manager README file (or FREADME file for the 
fax software) for additional installation guidelines and tips.

The following are general steps to determine if the problem is in the 
Message Manager software, your PC, the LAN, the switch, the AUDIX 
server, or a combination of these.
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To troubleshoot a previously working copy of Message Manager:

1. If the Message Manager program seems to have locked, there may be a 
Windows or PC problem.  Try exiting and restarting Windows and 
Message Manager (if possible).  Otherwise, try rebooting your PC. 

— If the reboot works, bring up some other PC application to see if 
your PC is functioning properly (such as a word processor or a 
spreadsheet).  If the PC appears to be okay, go to step 2.

— If the reboot fails or you find other PC problems, call your PC repair 
person.

2. If Message Manager cannot connect to the AUDIX server or play 
messages, pick up your phone and dial the telephone number for your 
AUDIX system. 

 If the AUDIX system answers and allows you to log in, the AUDIX 
server probably is not the problem.  To make sure, try logging into 
Message Manager from another PC, or find out if other Message 
Manager users can log in.  If they can, go to step 3.

 If the AUDIX server doesn't answer, is busy, or won't let you or 
other users log in, it may be down.  Report the problem to your 
AUDIX system administrator.

3. To check your LAN and TCP/IP software:

— Bring up any other Windows application that uses the LAN (for 
example, print a file over the network or connect to a network 
drive).  If you can, the LAN is probably working.  Go to step 4.

— Check the physical connections between the LAN and your PC.  
Reseat loose connectors, or call your LAN administrator if any 
cables are unplugged.

— From Windows, attempt to ping the AUDIX server by name and by 
TCP/IP address using the ping utility that came with your TCP/IP 
software (ping is a diagnostic packet that checks the connection 
between a LAN server and a specific address).  You must run ping 
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from a DOS box within Windows (running a ping from the DOS 
shell without Windows running is not a good test).  See your LAN 
administrator if you need help running ping.

— Check that the correct TCP/IP drivers have been installed on your 
PC.  These are typically installed in the 386 Enhanced section of the 
Windows system.ini file (for example, DEVICE=[path]VTCPIP.386 
or DEVICE=[path]VPTCP.386).  See your LAN administrator if you 
need help.

— Make sure that the TCP/IP files including WINSOCK.DLL are 
installed in the correct directory on your system, and that each 
required directory is in your DOS path.

A software tool is available to help check the networking 
interface between the Windows operating system (including 
TCP/IP) and the LAN on a user's PC.  This tool can help 
verify that a PC is ready to run Message Manager, or help 
diagnose why Message Manager no longer works on a PC 
that used to run it.  Contact your LAN or system 
administrator about this tool, or ask them to contact their 
AT&T representative.

4. To check your telephone switching system:

— Have someone call you.  If your phone works, have them call you 
again (or call yourself from another phone) and make sure the call 
eventually covers to the AUDIX system.

— If your phone or coverage-path doesn't work, contact your 
telecommunications person.  Otherwise, the switch is probably not 
the problem.  Go to step 5.

5. If you still can't figure out the problem, call your AUDIX system 
administrator to report a problem with Message Manager. 

— Verify that the AUDIX system administrator has correctly 
administered you to use the Message Manager feature.

— Report the problem as specifically as possible to aid in 
troubleshooting.



Installation or Setup Problems

Issue 1   January 1995 93

Installation or Setup Problems
The following problems may affect your use of Message Manager:ν

Color Resolution.  If you set your video display to 65,000 colors, the 
Message Manager drag and drop icons (such as the envelope icon on the 
main screen) may turn black or distorted, even though they still work.  Use 
a maximum of 256 colors to correct this.

File Properties.  If you change any Program Item Properties for Message 
Manager (for example, if you want to change the icon), make sure the 
Command Line continues to call for MSG_MGR.EXE (such as C:\MSG_
MGR\MSG_MGR.EXE).  Otherwise, you'll receive an error.

LAN Workplace for DOS 4.2.  Make sure you have the most recent 
WINSOCK.DLL (refer to your LAN Workplace documentation for the 
phone number of the bulletin board from which to download 
WINSOCK.DLL and patches).  You also need to set up some form of 
name-resolution system.  Either activate the DNS (Domain Name System) 
capability or put the AUDIX server name and IP address in the host file on 
each client PC.  Message Manager is unable to locate the AUDIX server by 
IP address using a LAN Workplace TCP/IP stack.

Memory Contention.  You may occasionally see an error message 
indicating that there is not enough memory to run Message Manager or 
some of its functions.  To free up memory, close any nonessential 
applications that are running under Windows.  If the PC still has 
memory-contention problems, restart Windows (or reboot your PC), then 
close any nonessential applications that come up automatically.  Try 
running Message Manager again.  If you still have problems, see your LAN 
administrator.
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To check how much Windows conventional memory is available:

1. In Program Manager, select the Help menu option, then select About 
Program Manager.

2. At the bottom of the screen that appears, check the System Resources 
line (this shows how much conventional memory is available).

3. Close other applications to free up more of this shared memory (check 
this screen periodically).  Generally, you'd like to free as much system 
resources as possible.

Problems Using Message Manager
This section describes some specific Message Manager problems and their 
resolution procedures.

Can't Log Into Message Manager.  If you can't get past the Message 
Manager Login screen, you probably have a problem with the network or 
the TCP/IP drivers installed on your PC.  If Message Manager reports a 
General Protection fault, improper installation of the TCP/IP software is a 
likely cause.  Follow the LAN troubleshooting steps on the previous page, 
then try logging in again.

Message Manager Locks Up.  If the Message Manager application fails to 
respond (becomes locked up):  (1) try exiting then restarting Message 
Manager.  If this doesn't  work, (2) try rebooting your PC.  If this still 
doesn't work, (3) check to see if your other Windows applications work, or 
call your LAN administrator.

Message Manager Doesn't Display Correctly.  If you have trouble 
displaying Message Manager and you are using an SVGA (Super VGA) 
monitor, change it to VGA.  This application may not be compatible with 
some SVGA drivers.  You may be able to change this using the Control 
Panel icon on your Program Manager window, or you may need to load 
new drivers on your PC.  Refer to your Microsoft Windows documentation 
or ask your PC administrator to assist you.
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Your Phone Doesn't Ring.  You may be using the wrong audio connection 
number.  First, select the Hang Up button (the audio connection indicator) 
on the main screen to disconnect the current audio connection (otherwise, 
someone else may be listening to your message!).  Next, check your audio 
connection number through the Server menu on the main screen.  Make 
sure the telephone number you type matches the extension of the phone 
you are currently using.

Message Manager Doesn't Notify You of New Messages.  If the Message 
Manager icon never raises its flag when you have messages in the New 
folder, your AUDIX system administrator may not have activated the 
AUDIX server to check for new messages.  (In this case, you also cannot 
access New Message Alerting or Check For New Messages under the 
Options menu.)  Ask your AUDIX system administrator to activate the 
Automatic Check For New Messages Enabled field.

A Message Failed to be Delivered.  Occasionally you may receive a new 
message from the AUDIX system informing you that a message failed to be 
delivered.  In this case, access your Outgoing folder as described in 
Chapter 6.  Select the message that failed, then access the Message Delivery 
Report (see ‘‘Using the Outgoing Folder’’ for details).  The report shows 
the reason the message could not be delivered.  Correct the problem if 
possible and send the message again.  See the online help for details about 
re-sending failed messages and failure reason explanations.

Fax Problems
You may see the following problems when you're using the optional fax 
software.

■ Not Fax Enabled.  Before you can use the optional fax software, the 
following items must be set up to support fax:

— On the main screen, select Options.  Try to select fax.  If you cannot 
select the fax option, you are not fax enabled.  Re-install the fax 
software or see your LAN or system administrator.
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— If the Fax Options screen appears, check the AUDIX server status 
field and AUDIX mailbox status field.  They must both be enabled to 
support fax messaging.  If they are not enabled, see your system 
administrator.

No Default Printer.  If you do not have a default printer assigned, you 
must exit Message Manager before you assign a default printer using 
Windows Control Panel.  Otherwise, Message Manager errors may occur.

Fax Pauses Until Print is Done.  If you try to print a fax to a local or 
network printer through Message Manager and the print status remains at 
100% until the print job is done, do the following:

1. From the Windows Control Panel, select Printers.

2. In the Printers window, check the "Use Print Manager" box.

3. Close the Printers window.  The next time you try to print a fax, 
Message Manager will hand off the job to the print manager and you do 
not have to wait for the printer to finish.

HP LaserJet.  Due to problems with the HP LaserJet 4/4M print driver, 
faxes do not print correctly on this type of printer.  Either:

— Use the HP LaserJet III print driver for an HP LaserJet 4/4M type 
printer  or

— Install the fix for the HP LaserJet 4/4M print driver by downloading 
the Microsoft HPPCL5E.DRV Version 3.1.D1.08 file from 
Compuserve.

PostScript.  PostScript printers have the following problems:

— Printing is slow and creates huge files on your disk.  Depending on 
the size of the fax and amount of text or graphics in it, PostScript 
files may range from 10K to several hundred Kbytes per page.

— Currently only level 1 PostScript printers work with Message 
Manager.  Level 2 print drivers fail.
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WordPerfect.  Do not select more than 1 or 2 copies when you create your 
own faxes in WordPerfect.  If you select multiple copies when you generate 
a fax using the AT&T MM Fax Print Driver:

— Message Manager creates each page of the fax as many times as you 
have copies.  For example, if you select 5 copies, it will "write" each 
page of the fax 5 times.  

— WordPerfect then launches a separate instance of Message Manager 
for each copy requested.  For 5 copies of a fax, WordPerfect launches 
5 instances of Message Manager.  Because this is beyond the capacity 
of most PCs, each instance of Message Manager fails and no faxes 
are sent.  Exit Message Manager, change your print setup to request 
only 1 copy, then try to generate the fax again.
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AHot Keys

This appendix covers keyboard shortcuts when using Message Manager.

■ For screens with a menu bar, you can hold down the Alt key and press 
the underlined letter for the desired menu, then add any other letters 
needed to select the desired function.  For example, on the main screen 
you could press Alt and V, then F to view a fax.

■ Some menu options have control-key or "hot key" shortcuts (listed in 
the pulldown menus where available).  For example, the Ctrl+P option 
on many screens means you could press Ctrl and P to print a fax 
message to a local or network printer.  Otherwise, you would have to 
press Alt and F, then P to print a fax.

Keyboard shortcuts may change from screen to screen, so check 
your menu options.  For example, to print a fax on the main 
screen you would have to press Alt and F, then P, then P again.

■ For screens that do not have a menu bar, you can still use Alt key 
shortcuts for any underlined characters in fields or buttons.  For 
example, in the New Message Notification (Outcalling) screen, you 
could either tab to the Outcalling Notification Number field, or simply 
press Alt and N to instantly select it.

The following table lists Message Manager hot keys and their functions.
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Screen
Hot 

Keys Function

Main screen Ctrl+P Print a fax to a local or network printer

Ctrl+F Open the Fax Viewer

Ctrl+M Create a New Message

Ctrl+D Open the AUDIX Directory

Ctrl+B Open the Personal Phonebook

Ctrl+L Lock Message Manager

Shift+Del Empty the Wastebasket

Ctrl+N Move message(s)to the New Folder

Ctrl+U Move message(s)to the Unopened Folder

Ctrl+O Move message(s)to the Old Folder

F1 Access the online Help

Fax Viewer Ctrl+N Attach a fax already saved in the Document folder

F2 Backup a voice-fax message to the beginning

F3 Rewind the voice part of a Voice-fax message 5 seconds

F4 Stop message playback

F5 Begin message playback

F6 Move forward in a voice-fax message 5 seconds

F7 Advance the voice part of a voice-fax message to the end

Ctrl+P Print a fax to a local or network printer

Ctrl+I Zoom in

Ctrl+O Zoom out

Ctrl+E Enlarge the Fax Viewer Window

Ctrl+R Decrease the Fax Viewer Window
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AUDIX List
Administration
screen

Ctrl+X Remove selected text to the clipboard

Ctrl+C Duplicate selected text onto the clipboard

Ctrl+V Insert text from the clipboard into a text-entry 
fieldPersonal Phonebook

Ctrl+X Remove selected text to the clipboard

Ctrl+C Duplicate selected text onto the clipboard

Ctrl+V Insert text from the clipboard into a text-entry 
fieldMessage Creation and Transmission screen

Ctrl+X Remove selected text to the clipboard

Ctrl+C Duplicate selected text onto the clipboard

Ctrl+V Insert text from the clipboard to a text-entry field

Screen
Hot 

Keys Function



Hot Keys

cii Issue 1   January 1995



Glossary

Issue 1 January 1995 103

Accessed 
Message

A message you have sent where at least the header (if not 
the actual contents) has been played or viewed by all the 
recipients.

AMIS The Audio Messaging Interchange Specification (AMIS) 
feature allows voice mail to be exchanged through analog 
networking among both AT&T and non-AT&T machines.

Audio 
Connec-
tion

Message Manager places a call to your telephone when 
you play or record messages, greetings, or names.  This 
audio connection uses a voice port on the AUDIX server.

Audio 
Connec-
tion Num-
ber

This AUDIX system dials this telephone number when 
Message Manager needs to make an audio connection.  
Usually this is the extension at your desk.

Audio Pal-
ette

The audio palette provides VCR-type controls to play the 
currently selected message and to adjust its playback posi-
tion, speed, and volume.

AUDIX 
Directory

The directory contains a list of all the subscribers who are 
administered on your AUDIX server (it is equivalent to the 
**N Names and Numbers directory in the telephone inter-
face).

AUDIX 
Mailing 
List

A list of subscriber addresses stored on the AUDIX server.  
You can use an AUDIX mailing list to easily send messages 
to groups of subscribers who often need the same informa-
tion, or to eliminate repetitive addressing of long or 
unusual subscriber addresses such as networked or AMIS 
one-step subscribers, or administered Message Delivery 
recipients or fax machines.

AUDIX 
Server

The AUDIX messaging system that supports Message 
Manager.  Currently the DEFINITY AUDIX R3.1 (or later) 
and Intuity AUDIX R3.2 (or later) systems that support 
Message Manager voice messaging.  An Intuity AUDIX 
R3.3 system is required for fax messaging.
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AUDIX 
Server ID

The name or address that identifies the AUDIX server that 
your Message Manager application communicates with.  The 
server ID can be a name (such as "vmail2") or an IP address 
(numbers in a nnn.nnn.nnn.nnn type format).

AUDIX 
Telephone 
Interface

You can dial the AUDIX server through your telephone to 
access your messages or other AUDIX messaging features by 
using touch-tone commands entered through your telephone 
keypad.  Message Manager translates subscriber names and 
list IDs to their touch-tone equivalents so they are accessible 
through the telephone interface. 

Autoprint The AUDIX server allows new incoming faxes to be printed 
automatically at a fax machine (or other fax endpoint, such as 
a PC fax modem) of your choice.  Only the fax part of new 
incoming messages is printed (private fax messages are only 
printed on request).

Call 
Answer 
Feature

This feature allows the AUDIX system to answer your calls 
when you don't answer your phone (for example, if your line 
is busy or you don't answer).  You may record your own per-
sonal greeting that callers will hear when they are redirected 
to the AUDIX system.

Call 
Sender

You can have Message Manager place a call to the sender of a 
message automatically, if the person is administered on your 
system and the Transfer Out of AUDIX feature is active.

Compo-
nent

The type of message you have created or received is shown by 
a screen button or message list icon.  Voice messages show an 
audio cassette, fax messages show a fax printer, and 
mixed-media messages have both.  Messages in the message 
list that show no media icon are text-only messages, such as 
system-generated messages or status notifications.  Message 
Manager and the AUDIX server treat mixed-media messages 
as a unit.  For example, if you drag a voice-fax message to the 
Personal or Wastebasket folder, all parts of that message 
(voice, fax, and header) are either copied or marked for dele-
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tion.  The exception is the Document folder, where only the 
fax part of a message is stored.

Create 
New Mes-
sage

The basic Message Manager activity used to record, 
address, and send a new voice, fax, or voice-fax message.

Delivered 
Message

A message you have sent that has been delivered to all 
recipients' mailboxes, but the recipients have not read, 
accessed (played or viewed) the message. 

Document 
Folder

This folder stores faxes you create on your PC or another 
LAN storage device.  You can store faxes in your Docu-
ment folder when you create a new fax or if you copy a fax 
to your Document folder.  You should always include a 
subject for faxes you save so you can identify them later.

Expanded 
Message 
Display

The main screen's expanded message display expands the 
status abbreviations used in the message list (such as Pri-
vate or Priority status) and shows the complete Subject for 
messages that have a text description.  The media button 
labels show the length of the message (seconds for voice or 
pages for fax).

Extension 
Number

Your extension number is a 3-to 10-digit number that iden-
tifies your subscriber mailbox on the AUDIX server.  This 
number is typically the same as the one on your desk top.

Failed 
Message

This is a message that could not be delivered to the 
intended destination or recipient(s).

Fax-enable
d

Capable of supporting the optional fax feature.  Subscrib-
ers need three things to be fax-enabled for Message Man-
ager: (1) a fax-enabled AUDIX server such as Intuity 
AUDIX R3.3, (2) fax permission assigned to their AUDIX 
mailbox, and (3) the Message Manager fax software 
installed on their PC.

Fax Print 
Prefix

A system administrator-specified prefix for sending fax 
messages to a fax endpoint (such as a fax machine or PC 
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fax modem).  If a prefix is used, you must type these numbers 
before the extension number for any fax you send to a fax end-
point (not a LAN printer).  For example, if the prefix is 3 or f 
(for fax), you could type 3 followed by 1234 to send a fax to a 
local fax machine whose extension is 1234.

Fax 
Viewer

The Fax Viewer allows you to display (and optionally print or 
export) any fax messages you create, send, or receive in Mes-
sage Manager.

File Cabi-
net Folder

A folder in Message Manager that keeps a copy of a message 
you created.  The description (if any), creation time, and first 
recipient in the delivery list appear in the message list sum-
mary.  You can keep a File Cabinet copy for reference, or for-
ward the message if desired to a new list of recipients.  
Because File Cabinet messages are store on the AUDIX server, 
they automatically expire at a system-administrator specified 
time interval, you may copy a File Cabinet message to your 
Personal or Document folder for longer storage.

Folders The list of message categories that appear on the main screen.  
The New, Unopened, and Old folders correspond to the 
incoming mailbox in the telephone interface.  The File Cabinet 
and Outgoing folders correspond to the outgoing mailbox in 
the telephone interface.  The Personal folder, Document folder, 
and Wastebasket are unique to Message Manger.

Forward 
Message

You can send a message you received to one or more addi-
tional recipients.  In most cases, you must also include a new 
message of your own (for example, a voice message warning 
the new recipient that a forwarded message follows your 
own).  You cannot forward Private messages.

Headers A summary of printable information that is associated with a 
message (status, subject, recipient/sender, and so on).  The 
complete text of a selected message header appears in the 
expanded message display, and an abbreviated version 
appears in the message list on the main screen.  Each message 
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header takes about 1 second to retrieve from the AUDIX 
server.

Immedi-
ate Deliv-
ery

The standard delivery time for a message where you sim-
ply select the Send button on the Message Creation and 
Transmission screen without scheduling a future delivery 
time and date.  The system attempts the earliest possible 
delivery of your message (usually about 1 minute).  
"Immediate" deliveries may be delayed if messages are 
addressed to networked subscribers or if a recipient's mail-
box is full.

Incoming 
Mailbox

This mailbox on the AUDIX server consists of the New, 
Unopened, and Old folders.  In the telephone interface, 
messages move automatically from one category to the 
other as you listen to them.

LAN A Local Area Network (LAN) is a group of machines that 
communicate over some high-speed media, typically 
within a small geographic area (thousands of feet).  The 
LAN is independent of the Message Manager product.  
However, Message Manager requires an Ethernet connec-
tion to a network running TCP/IP.  A token-ring network 
is supported only if an appropriate router is installed to 
convert the token-ring protocol to Ethernet protocol.

Lock 
Feaure

This feature provides an extra level of security for your 
minimized Message Manager application because you can 
only restore it after providing your AUDIX password.  A 
raised door on the Message Manager mailbox icon indi-
cates that the application is locked, and a raised flag indi-
cates that you have new messages.

Log Off There are two ways to log off Message Manager.  The first 
is when you manually exit Message Manager and close the 
application.  Another kind of logoff occurs in the back-
ground when your copy of Message Manager is no longer 
actively communicating with the AUDIX server.  If you see 
a "server logoff" message in your dynamic help field, Mes-
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sage Manager has released a LAN resource for use by other 
Message Manager users, but it will still check for new mes-
sages if that feature is enabled on the AUDIX server.  You are 
also logged off the server when you minimize or lock Message 
Manager.

Main 
Screen

This screen contains the folder list, message list, audio palette, 
and buttons used to display, play, and respond to messages.  
Message Manager menus, toolbar buttons, and status indica-
tors are also available on this screen.

Message 
List

The message list on the main screen shows the Media (voice 
and/or fax or none) and who the message is From (for the 
New, Unopened, and Old folders), To (for the Outgoing and 
File Cabinet folders), or its Description (for the Personal, Docu-
ment, or Wastebasket folders).  You may slide the <Subject> 
label to either side to show more or less of a message's 
description.  The time, date, and Status abbreviation (such as ! 
for Priority or P for Private) is also shown.

Message 
Options

Options for message creation and delivery are selected on the 
Message Creation and Transmission screen.  These include 
options to make messages Private or Priority, save a copy in 
the File Cabinet, print delivery data, and (if you are replying 
to or forwarding a message) include the original message.

New 
Folder

This folder contains your new incoming messages.  You may 
access your messages in any order, although you may want to 
check the Status column to see if you have any ! (priority) mes-
sages.  Any message in the New folder (whether you have lis-
tened to it or not) activates your notification of new messages 
features.  The only exception is a login announcement.

Notifica-
tion of 
New Mes-
sages

Message Manager uses several ways to notify you of new 
messages including Outcalling, a raised flag on the mailbox 
icon, and the New Message Alerting feature (a pop-up mes-
sage box when you are using Windows applications). 
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Old Fold-
ers

This folder contains messages moved from the New or 
Unopened folders that you want to keep around for a 
while.  In the telephone interface, new messages automati-
cally move to this category after you listen to them.  In 
Message Manager, you must manually move messages 
you wish to save to another folder to cancel your new mes-
sage notification features.

Outcall-
ing Fea-
ture

This feature allows the AUDIX system to call you to notify 
you of new messages.  After an initial delay (typically 15 
minutes), the AUDIX system rings the phone at the num-
ber you specify if you have new (or new priority) mes-
sages.  You can then log in through the telephone interface 
to listen to the new messages, or cancel the call by pressing 
*#.

Outgoing 
Folder

This folder on the main screen contains message status 
notifications for messages that you have created yourself 
and sent to others.  Any outgoing messages or status noti-
fications you delete or move to the Wastebasket folder are 
immediately deleted and cannot be recovered.  You can 
access and re-send messages with a status of Failed 
through the Message Delivery Report.  Messages with a 
status of Scheduled are still in your mailbox awaiting deliv-
ery, and may be deleted but not altered.  Messages that 
show a status of Delivered or Accessed have already been 
transmitted to the recipient's address and cannot be 
recalled, altered, or deleted from the recipient's machine 
(although you can delete this status notification from your 
message list).

Password Your password helps prevent unauthorized access to your 
messaging system.  Generally, a longer password provides 
greater security (5 or 6 digits are recommended).  Because 
your Message Manager password is shared with your 
AUDIX server, changing your password in one place 
updates the password for both your PC and telephone 
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interface.  When you type a password, asterisks appear 
instead of the actual characters for security purposes.

Personal 
Folder

This folder that allows you to store copies of messages on a 
PC, diskette, or LAN storage device until you specifically 
choose to delete them.

Personal 
Greetings

This feature allows you to record a personal message for call-
ers who reach the AUDIX system through the Call Answer 
feature (whenever you don't answer an incoming call).  
Depending on your system administration, you may have up 
to 9 Multiple Personal Greetings, 2 Multilingual Greetings, or 
a single personal greeting.

Personal 
Phone-
book

The Personal Phonebook allows you to save names, numbers, 
and addresses of people you frequently contact or send mes-
sages to, along with your own notes.  You can use these card 
entries for your own reference (for example, when Message 
Manager or the AUDIX server is not running) or to simplify 
message addressing. 

Prefix One or more digits assigned by the AUDIX system adminis-
trator that must be entered as the first part of an extension or 
telephone number during message addressing.  Prefixes are 
often needed on large networked systems.  Administrators 
may assign prefixes based on the type of message (such as 3 or 
f for fax) or location (such as 201 for an area code).  Because 
prefixes vary from site to site, your system administrator must 
provide all relevant information on prefixes.

Priority 
Message

The system gives priority messages privileged treatment.  Pri-
ority messages get a ! (exclamation) status in the message list 
on the main screen.  They appear at the front of the new mes-
sage queue when recipients access their new messages, and 
they may trigger New Message Notification (Outcalling).  To 
make a message priority, check the Priority option on the Mes-
sage Creation and Transmission screen.  (If you do not have 
Priority permission, this field is grayed out.  Contact your 
AUDIX system administrator.)
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Private 
Message

Private messages have a status abbreviation of P and can-
not be forwarded by the recipient(s) to other users.  To 
make a message private, check the Private option on the 
Message Creation and Transmission screen.  You cannot 
send private AMIS messages.

Recipient A person to whom you address a message, or an adminis-
tered endpoint such as a fax machine.  Recipients may be 
added individually prior to sending a message, or stored 
in an AUDIX mailing list or your Personal Phonebook.

Refresh You can update the contents and message count of a 
selected folder either by selecting a folder on the main 
screen or by using the Refresh option on the main screen's 
Folder menu.  You may wish to update a folder's contents 
if you are waiting for a message to appear, or if you have 
been logged off the AUDIX server and want to make sure 
your display is current when you switch back to the Mes-
sage Manager window (especially if you logged into the 
AUDIX server through the telephone interface in the mean 
time).

Relogin A Message Manager option that allows you to log into 
your mailbox if a login is already active (the AUDIX server 
does not allow two logins to one mailbox at the same 
time).  The active login may be through the telephone 
interface or another copy of Message Manager (for exam-
ple, if a coworker or secretary is monitoring your mailbox, 
or if you left Message Manager running in the back-
ground).  If you choose to relogin, Message Manager can 
drop an existing PC login in favor of your new login 
request, but you must hang up an active connection 
through the telephone interface yourself.

Remote 
Access

The ability to access Message Manager over a modem if 
you are off-premises or otherwise cannot directly connect 
to the LAN.
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Reply to 
Sender

This feature allows you to reply to a message sender using 
automatic addressing.  You need only to include a new mes-
sage component in your reply to send a response.

Retention 
Times

The retention time is how long messages are stored on the 
AUDIX server before being automatically deleted.  You may 
be able to save copies of messages longer than this by asking 
the system administrator to increase your retention times or 
by storing copies of messages in your Personal or Document 
folder.

Scan Fold-
ers

Message Manager updates the contents and message count of 
the folders on the main screen by periodically connecting to 
the AUDIX server over the LAN.  Message Manager pauses 
each time it scans a mailbox (up to 1 second for each message 
entry).  Folders are updated in groups.  You can also update a 
folder's contents using the Refresh option on the Folder menu.

Schedule 
Delivery

You may schedule a delivery time up to one year in the future 
using the Message Delivery Time screen through the Message 
Creation and Transmission screen.  You are never required to 
schedule a delivery time.  The standard delivery time is 
"Immediately", where the system attempts the earliest possi-
ble delivery (usually about 1 minute) after you select Send. 

Sched-
uled Mes-
sage

A message you have created that has not yet been delivered 
(for example, if a recipient's mailbox was full or an address 
was incorrect).  Scheduled messages appear in the Outgoing 
folder and still have their associated media component(s).  A 
scheduled message is equivalent to an undelivered message in 
the AUDIX telephone interface.

Server 
Data

Options and operating parameters that the AUDIX system 
administrator has assigned for the entire messaging system.  
These restrictions and capabilities are shared by all subscrib-
ers on the same AUDIX server (for example, the feature to 
transfer calls or automatically check for new messages).
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Server 
Timeout

Because LAN resources are limited, Message Manager 
keeps track of how long you are connected to the AUDIX 
server.  If you don't interact with the server for the system 
administrator-defined timeout interval, Message Manager 
logs off (disconnects from) the server and any work you 
might have had in progress is lost.

Status 
Informa-
tion

The main screen shows the status of messages (priority, 
private, broadcast, and so on) in the expanded message 
display and in the message list.

Subject A text description of messages you send or receive.  Up to 
64 characters may be entered or altered using standard 
Windows editing techniques.

Subscriber A person who has been assigned a mailbox with Message 
Manager permission on the AUDIX server.

Sub-
scriber 
Data

Options and information that the AUDIX system adminis-
trator has assigned to a specific subscriber.  The system 
administrator may be able to change these options upon 
request (such as message retention time, mailbox size, or 
feature permissions).

Sub-
scriber 
Name

The AUDIX system plays a recording of your name over 
the telephone interface in several cases (if no personal 
greeting is recorded, to identify a message sender, and so 
on).  Depending on your AUDIX server administration, 
you may be able to re-record your subscriber name (for 
example, to correct its pronunciation or add a brief impor-
tant message such as, "Pat Lee, on vacation until May 
third."). 

TCP/IP The Transmission Control Protocol/Internet Protocol 
required on the LAN and your PC to support Message 
Manager communications with an AUDIX server.  This 
protocol was originally defined for the Internet but is now 
widely used in private networks.
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Title Bar The main screen's title bar shows the subscriber currently 
logged into Message Manager.  Subscriber information also 
appears in the label if you minimize or lock Message Manager 
(this allows someone monitoring two mailboxes, for example, 
to tell which subscriber's mailbox received a new message).  
You can use the label as a guide for entering subscriber names 
(for example, last-name-first) or to reposition the Message 
Manager window on your screen.  The control box appears at 
the left, allowing you to reposition, resize, or close the applica-
tion.  The minimize/maximize buttons appear on the right.

Toolbar The toolbar allows one-button access to common Message 
Manager activities (the Activity menu allows keyboard access 
to these toolbar functions).  See Chapter 2 for more informa-
tion.

Transfer 
Out of 
AUDIX

The *T (Transfer Out of AUDIX) feature allows callers or sub-
scribers to transfer out of the AUDIX system to reach another 
extension or telephone number in your switching system.  
Call Transfers Out of AUDIX must be active for the Call 
Sender, Covering Extension, and Call Subscriber (from the 
AUDIX Directory screen) features to work.  Contact your sys-
tem administrator if needed to find out if this feature is active 
on your system.

Undeliver-
able Mes-
sage

Undeliverable (or Nondeliverable) messages are generated by 
the AUDIX system when a message could not be delivered 
(for example, if a recipient's mailbox was full or an address 
was incorrect).  In the AUDIX telephone interface, this notifi-
cation appears in your incoming mailbox, and the undeliver-
able message is saved in your outgoing mailbox.  In Message 
Manager, undeliverable messages appear in the Outgoing 
folder with a Failed status, and can be corrected and sent 
again through the Message Delivery Report screen.

Unopened 
Folder

This folder contains messages moved from the New folder 
that you have not yet had time to listen or respond to.  In the 
telephone interface, messages automatically move to this cate-
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gory if you listen to the headers but do not play or print 
the actual message.

Waste-
basket

The Wastebasket folder holds messages from other folders 
that are marked for deletion.  The messages continue to 
take up storage space and remain linked to their original 
categories until they are actually deleted (either when you 
empty the wastebasket or exit Message Manager).
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1Index

A
Activate a Greeting, 58
Adding a Card, 43
Adding a Personal Phonebook Card, 43
Adding Addresses from a Public Mailing 

List, 38
Adding Entries to the Phonebook, 51
Address a Message, 36
Address Using a Mailing List, 37
Addressing a Single Recipient, 36
Addressing Using a Mailing List, 37
Administer Mailing Lists, 60
Administer Outcalling Notification, 62
Administer Personal Greetings, 55
Audio Connection Inactivity Timeout, 84
Audio Connection Indicator, 26
Audio Connection Number, Change, 60
Audio Palette, 26
AUDIX Directory, 59
AUDIX Directory Screen, 59
AUDIX List Administration, 60
AUDIX List Administration Screen, 61
AUDIX Server Interactions, 83

C
Can't Log In, 94
Change AUDIX Password, 60
Change Server Data, 60
Check For New Messages Option, 24, 95
Closing the Personal Phonebook, 53
Comments About This Book, xii
Confirm Deletions Option, 31
Conventions Used in This Book, x

Cover Page, 78
Covering Extension, Change, 60
Create a Message, 34
Create Personal Folder Directories, 82
Creating a Cover Page, 78
Creating a New Fax, 75
Creating a New Mailing List, 61

D
Delete Messages, 31
Deleting a Card, 47
Deleting a Personal Phonebook Card, 47
Deleting an Address, 37
Document Folder, 72
Dynamic Help Field, 18

E
Editing a Card, 47
Editing a Personal Phonebook Card, 47
Empty Wastebasket, 31
Exit Message Manager, 19, 21
Exporting a Fax, 79

F
Fault Isolation, 89
Fax

Cover Page, 78
Creating a New Fax, 75
Exporting, 79
Print, 65
Printing on a Fax Machine, 72
Printing on a Local or Network 

Printer, 71
Receiving and Viewing a Fax, 68



Index

118 Issue 1 January 1995

Saving, 76
Sending, 75
Sending a Stored Fax, 77
Setting Your Fax Options, 74

Fax Cover Page screen, 78
Fax Option, 3
Fax Problems

Fax Pauses, 96
HP LaserJet, 96
No Default Printer, 96
Not Fax Enabled, 95
PostScript, 96
WordPerfect, 97

Fax Viewer, 68
Feature Summary, 2
Field Help, 19
Folder

Outgoing, 64
Folder Descriptions, 29
Folders, 28, 81

Document, 29
File Cabinet, 29
New, 29
Old, 29
Outgoing, 29
Personal, 29
Unopened, 29
Wastebasket, 30

Forward a Message, 40

G
General Protection Fault, 94
Greetings

Multilingual, 58
Multiple, 56
Single, 59

H
Hang Up Audio Connection, 26
Hardware and Software Requirements, 4

I
Install from Diskette, 5
Install from the Server, 8
Install Message Manager, 5
Installation

Fax, 7
From Diskette, 5
From the Server, 8
Hardware and Software, 4
Prerequisites, 4
Tutorial, 10
Upgrading to Release 2.0, 5

Installation or Setup Problems, 93
Color Resolution, 93
File Properties, 93
LAN Workplace, 93
Memory, 93

Installation Prerequisites, 4
Installing the Fax Option, 7
Installing the Tutorial, 10
Installing the Tutorial from Diskette, 11
Installing the Tutorial from the Server, 11

L
Learning About Message Manager, 17
List Selection Screen, 37
Listen to Messages, 25
Lock Message Manager, 19
Locked Out of Mailbox, 16, 84
Log Into Message Manager, 15
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M
Mailbox Flag Raised, 23
Mailbox Space Indicator, 31
Main Screen, 17
Message Creation and Transmission 

Screen, 35
Message Delivery Options, 39
Message Delivery Time Screen, 39
Message Headers, 2, 25, 81, 83
Message List, 25
Message Manager

Features, 2
Installation, 5
Main Screen, 17
Overview, 2, 17
Troubleshooting, 94
Tutorial, xi

Message Manager Error Screen, 90
Message Manager Features, 2
Message Manager Main screen, 17
Messages

Address, 36
Create, 34
Delete, 31
Forward, 41
Listen to, 25
Move or Copy, 28
Print Reports, 66
Record, 34
Reply to Sender, 40
Schedule Delivery, 39

Minimize Message Manager, 19
Monitor Your Mailbox, 20
Move Messages Between Folders, 28
Moving Messages Between Folders, 30
Multilingual Greetings, 58
Multiple Copies of Message Manager, 20
Multiple Personal Greetings, 56

N
New Message Alerting Option, 23
New Message Notification Methods, 23
New Message Notification Screen, 63

O
Online Help, 18
Outcalling Notification, 24, 62, 63
Outgoing Folder, 64

P
Password, Change, 60
Password, Enter, 16, 19
Personal Folder, 81

Archive to Diskette, 82
Copy Messages, 28, 82
Create Directories, 82
Play Messages, 83
Storage Requirements, 81

Personal Greeting Administration 
Screen, 56, 58
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INTUITY™ Message Manager 
Release 2.0 User’s Guide 
Addendum

This addendum covers changes between Release 2.0 and Release 2.2 of the 
INTUITYTM Message Manager message-handling software. It supplements 
the INTUITY Message Manager Release 2.0 User’s Guide (585-310-731).

Release 2.2 Features

Message Manager Release 2.2 enhancements include:

■ Operating Systems. Support has been added for the following 
Microsoft® WindowsTM operating systems:

— Windows NT version 3.51 or higher (16 MBs RAM recommended)

— Windows 95

The Message Manager Setup program automatically tailors Message 
Manager to work with the operating system installed on your PC. 

— Message Manager runs as a 16-bit application on Windows 95 and 
Windows NT.

— Windows NT users who install the optional fax software must log in 
as an administrator in order to install a print driver.

— If you change operating systems, you must reinstall Message 
Manager. Also, if your PC is set up to run multiple operating 
systems (such as Windows NT and Windows 95), Message Manager 
must be installed separately for each operating system.
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■ Personal Folder. Message Manager now displays all messages stored in 
a Personal folder, regardless of the user’s extension. Prior to Release 2.2, 
users who shared a PC could see only their own messages when they 
accessed a Personal folder. With the Release 2.2 enhancement:

— Users with multiple extensions can see all their messages at once.

— Administrators can more easily change extension numbers.

— Users monitoring another user’s mailbox can save messages in a 
Personal folder and still have the other user be able to retrieve them.

■ FastCall. Message Manager provides access to the FastCall call-control 
application, allowing users to handle telephone calls through their PCs. 
When integrated with Message Manager, FastCall allows you to:

— Make external calls through your PC (for example, using numbers 
stored in your Personal Phonebook).

— Associate FastCall with an application so an incoming call displays 
the appropriate card in the Personal Phonebook.

— Place calls from the AUDIX® directory or return calls to a message 
sender directly, without needing to use the AUDIX system’s 
Transfer Out of AUDIX feature.

FastCall is purchased and installed separately. Refer to the online help 
for details on integration options, features, and access.

■ Shared Executable. Multiple users can now run Message Manager 
using a single shared copy installed on a LAN file server. Instead of 
simply distributing copies of software that are installed on each user’s 
PC, LAN administrators can now install a single copy of Message 
Manager that can be shared by all users at their site. This enhancement 
is detailed in the following section.
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Message Manager Installation

Message Manager software can be installed in three ways:

■ Diskette. Each user can install a personal copy of Message Manager on 
their PC using the application software diskettes.

■ Copy from LAN Server. Each user can install a personal copy of 
Message Manager on their PC by accessing the software through a LAN 
server. This method allows administrators to easily distribute Message 
Manager through the LAN instead of passing around diskettes.

■ Run from LAN Server. Multiple users can share a single copy of 
Message Manager that the LAN administrator has installed on a LAN 
server. Because the Message Manager software exists only on the LAN 
file server, it can be easily updated by the LAN administrator.

NOTE:
If you copy Message Manager software to a LAN file server for 
easy distribution and install a shared copy of Message Manager 
software for users to run on the LAN, the copy of the software 
diskettes and the executable Message Manager software must be 
in different directories.

The chart on the following page summarizes the different types of Message 
Manager installation. 

Upgrading to Message Manager Release 2.2

If you plan to upgrade to Message Manager Release 2.2:

■ Exit Message Manager. Do not install Message Manager Release 2.2 
while an earlier release of Message Manager is running.

■ To save a copy of your current Message Manager software, enter a new 
directory name and program group when you install Release 2.2.

See Chapter 1 in the INTUITY Message Manager Release 2.0 User’s Guide for 
other important pre-installation information. 
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The following chart summarizes methods of Message Manager (MM) 
installation. Each procedure is fully described on the referenced pages.

NOTE:
Release 2.2 software includes three (3) Message Manager diskettes, 
but only LAN administrators who are installing a shared copy of 
Message Manager are prompted for the third diskette.

Type Who What to Do Result See

Diskette 
Installation

Each user Run Setup, do not 
check the “shared 
copy” box

Copy of MM 
on user’s PC

Pages 6 to 8 
in the user’s 
guide

Copy of MM 
Distributed 
through 
LAN

1. LAN 
administrator

Copy the software 
diskettes to a LAN 
file server

Copy of MM 
diskettes on a 
LAN server

Page 5 
in this 
addendum

2. Each user Copy the software 
through the LAN 
and run Setup, 
do not check the 
“shared copy” box

Copy of MM 
on user’s PC

Pages 5 to 7 
in this 
addendum

Shared Copy 
of MM on a 
LAN Server

Shared MM 
Phonebook 
(Optional)

1. LAN 
administrator

Run Setup, do 
check the “shared 
copy” box

Copy of MM 
on a LAN file 
server

Page 7 
in this 
addendum

2. Each user Run Setup through 
the LAN (the 
“shared copy” box 
does not appear)

MM data 
files for that 
user only on 
user’s PC

Page 9 
in this 
addendum

1. LAN 
administrator

Move the 
Phonebook files to 
a shared directory

Phonebook 
accessible by 
all users

Page 8 
in this 
addendum

2. Each user Make Phonebook 
icon point to the 
shared directory

Shared 
Phonebook 
now available

Page 10 
in this 
addendum
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Distributing Message Manager through the 
LAN

Administrator Steps. LAN administrators may copy the Message Manager 
software diskettes to a LAN file server for easy distribution as follows:

1. Create a directory for the Message Manager software on the LAN 
server (for example, mmappl). Copy all the voice-application diskettes 
to the same directory using any DOS or Windows copy method you 
like.

! CAUTION:
Do not run Setup!

2. Optional. If you ordered the fax software, create a different directory for 
it on the LAN server (for example, faxappl) and copy the software to it.

3. Give Message Manager users read-only permission to access the 
network drive and directories where the software is stored.

4. Tell subscribers the software is available and how to access it.

User Steps. Release 2.2 users must use the following steps to install their 
own copy of Message Manager from a LAN file server:

1. Log in to Windows and the network.

2. Connect to the network directory where the Message Manager software 
has been copied as follows:

— Access the Connect Network Drive screen using File Manager or the 
Map Network Drive screen on Windows 95.

— Select the appropriate drive and path to access the shared directory 
that contains the Message Manager software (such as mmappl). See 
your LAN administrator for this information if needed.

— When the correct directory is selected, choose OK. 
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3. Copy all the Message Manager software files to your own PC using any 
DOS or Windows method you like. 

NOTE:
This step is essential if the LAN file server is running a different 
version of software than your PC (for example, if the LAN server 
is running Windows NT and your PC is running Windows 95).

4. Optional: To install the fax software, repeat steps 2 and 3, this time 
accessing the network drive and directory where the fax software has 
been copied (such as faxappl) and copying it to your PC.

5. After you install the Message Manager software (see the following 
steps), you can erase the mmappl and faxappl files and directories from 
your PC to free up space. 

To install the Message Manager software on your PC:

1. Access the Message Manager software directory that you copied to 
your own PC and run the setup program. 

2. You can accept the default directory (C:\MSG_MGR) or choose a 
different location.

3. You can use the default program group (INTUITY Message Manager) 
or enter another name. This group will contain the program icons.

4. Choose Continue to install the software. Message Manager installs the 
correct version for your PC’s operating system.

NOTE:
Do not check the box for installing a shared copy on a LAN server.

To install the optional fax software:

1. Change to the directory on your PC that contains a copy of the fax 
installation diskette, and run the setup program.

2. Install the fax software in the same directory that contains the rest of 
your Message Manager files.  The default is C:\MSG_MGR.
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3. Select the Continue button.  The fax software loads.

4. The INTUITY Message Manager Fax Setup screen then appears.  Enter 
the following information (needed when you create a fax):

— AUDIX Server ID.  This is the name or IP address of the fax-enabled 
server you use to send or receive messages.  See your LAN or 
system administrator for this information if needed.

— Mailbox Extension.  This is the extension number of the fax-enabled 
mailbox you'll be using to send and receive voice and/or fax 
messages.  This is usually the same number as your regular AUDIX 
mailbox.  Users with secondary fax extensions should not enter that 
number here, but type their regular mailbox extension.

5. Select the OK button to add this information.  If you select Skip, you 
can add the information later using the Fax Options screen. The 
installation is now complete.

Installing a Sh ared Copy of Message 
Manager on the Server

Administrator Steps. Generally, a LAN administrator should take the 
following steps to set up a shared copy of Message Manager on a LAN:

1. On a LAN file server, run the Message Manager setup program. When 
the INTUITY Message Manager Setup screen appears:

— Specify the directory (default C:\MSG_MGR) and program group 
(default INTUITY Message Manager).

— Check the box for installing a shared copy of Message Manager on a 
LAN server.

NOTE:
If you do not check the “shared copy” box, you will simply install 
a working version of Message Manager on the LAN file server.
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2. Select Continue. The Setup program installs a shared copy of Message 
Manager in the directory you specified, and creates a modified Setup 
program for users to run through the LAN.

3. Optional: If you ordered the fax software, insert the fax diskette and run 
the Setup program. Be sure to install the fax software in the same 
directory where you installed the Message Manager software.

If you checked the “shared copy” box in step 1, the Setup program 
creates an inst_fax directory. This directory contains a modified Setup 
program for fax users to run through the LAN.

4. Share the directory containing the Message Manager software. Allow 
read-only permission to protect the software.

5. Optional: If you wish to share the Message Manager Phonebook (for 
example, if users access a common database):

— Create a new directory for the Phonebook (such as pbook) that is not 
a subdirectory under the Message Manager directory. Share the new 
directory with full permissions so users can read and write to it.

— If you already have a Phonebook you would like to share, copy the 
following files from the Message Manager directory to the new 
Phonebook directory: pbook.ldb and pbook.mdb.

NOTE:
For a new Message Manager installation, these two files do not 
exist until the Phonebook is accessed and at least one entry made.

6. Run Message Manager. You must execute it at least once on the LAN 
server in order to set up the Document subdirectory.

7. Tell subscribers the software is available and how to access it. 
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User Steps. Generally, users should use the following steps to access a 
shared copy of Message Manager from a LAN file server:

1. Log in to Windows and the network.

2. Connect to the network directory where Message Manager is installed:

— Access the Connect Network Drive screen using File Manager or the 
Map Network Drive screen on Windows 95.

— Check the “Reconnect at Startup” (or “Reconnect at logon”) box. 
This allows you to reconnect to this drive automatically when you 
run Message Manager.

— Select the appropriate drive and path to access the shared directory 
that contains the Message Manager software (default MSG_MGR). 
See your LAN administrator for this information if needed.

— When the correct directory is selected, choose OK. The mapped 
directory files will appear.

3. Run the Setup program from the Message Manager directory.

— At the directory prompt, type the name of the working directory you 
wish to store Message Manager files in (default C:\MSG_MGR).

— Answer the program group prompt however you wish (default 
INTUITY Message Manager). This group will contain the Message 
Manager icons. Select Continue. 

The Setup program creates a data file in your working directory. You 
are now ready to run the voice-only Message Manager software.

4. Optional: To install the fax software, access the network directory where 
the fax software is installed (for example, inst_fax). Run the Setup 
program. Answer the prompts as follows:

— Specify the same working directory you used for the Message 
Manager software (for example, C:\MSG_MGR).

— Answer the prompts for AUDIX Server ID (fax-enabled server 
name or IP address) and Mailbox Extension (your AUDIX mailbox 
number). See page 7 in this addendum for details if needed.
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— Select the OK button to add this information, or select Skip to add it 
later using the Fax Options screen.

5. Optional: To access a shared Message Manager Phonebook (for 
example, if you share a database with other users), do the following:

— Select the Phonebook icon from the Message Manager program 
group (the default group name is INTUITY Message Manager).

— Change the Properties to point to the network drive and directory 
where the shared Phonebook is located. The command line must 
end with a /B (for example, m:\pbook /B).

6. You can now run Message Manager through the LAN. If you checked 
the “Reconnect at Startup” box (see step 2), the network drive 
containing Message Manager is accessed automatically. 

NOTE:
Message Manager makes a local (temporary) copy of its software 
in your PC’s RAM when it is first accessed, so shared-copy users 
might notice a slight delay when bringing up Message Manager 
over the LAN.

7. Optional: The shared copy of Message Manager uses by default the 
Personal and Document folders on the LAN server. To create your own 
message-storage folders (for example, on your PC):

— On the main screen, choose Select Personal Folder from the File 
menu. Navigate to the correct directory and drive, and choose OK. 
Message Manager will create a pfolder subdirectory for messages.

— Fax users may choose Select Document Folder from the File menu. 
Navigate to the correct directory and drive, and choose OK. 
Message Manager will create a document subdirectory for storing 
fax-only messages.


	Table of Contents
	About This Book
	Purpose
	Intended Audience
	How This Book Is Organized
	Conventions Used
	Trademarks and Service Marks
	Related Documentation
	How to Make Comments About This Book

	1. Introduction
	Message Manager Features
	Release 2.0 Features
	Fax Option

	Pre-Installation Requirements
	Hardware and Software Requirements
	Installation Prerequisites

	Message Manager Installation
	Upgrading to Message Manager Release 2.0
	Installing Message Manager Release 2.0 from Disket...
	Installing the Fax Option
	Installing Message Manager from the Server

	Tutorial Installation
	Installing the Tutorial from Diskette
	Installing the Tutorial from the Server


	2. Getting Started
	Logging In
	Learning About Message Manager
	Using Online Help
	Minimizing or Locking Message Manager
	Monitoring the Mailbox
	Exiting Message Manager

	3. Handling Incoming Messages
	Receiving New Message Notification
	Listening to Messages
	Using Folders
	Folder Descriptions
	Moving Messages Between Folders

	Deleting Messages

	4. Creating and Sending Messsages
	Creating a Message
	Recording a Message
	Addressing a Message
	Addressing a Single Recipient
	Deleting One or More Entries
	Addressing Using a Mailing List
	Adding Entries from a Public Mailing List

	Selecting Options and Scheduling

	Replying to Sender and Forwarding a Message

	5. Personal Phonebook
	Adding a Card
	Selecting a Card
	Editing a Card
	Deleting a Card
	Printing a Card
	Searching for an Entry
	Phonebook Databases
	Adding Entries to the Phonebook
	Standalone Personal Phonebook
	Closing the Personal Phonebook

	6. Other Standard Features
	Creating Personal Greetings
	Multiple Personal Greetings
	Multilingual Greetings
	Single Greeting

	Using the AUDIX Directory
	Changing Server Data
	Administering AUDIX Mailing Lists
	Administering New Message Notification (Outcalling...
	Using the Outgoing Folder
	Printing Information

	7. Fax Feature
	Receiving and Viewing a Fax
	Printing a Fax
	Printing a Fax on a Local or Network Printer
	Printing a Fax on a Fax Machine

	Using the Document Folder
	Setting Your Fax Options
	Sending a Fax
	Creating a New Fax
	Sending or Saving a Fax
	Sending a Stored Fax

	Creating a Cover Page
	Exporting a Fax

	8. More About Message Manager
	Using the Personal Folder
	Archiving a Message onto Diskette
	Listening to an Archived Message

	Working With the AUDIX Server
	Working with the Telephone Interface
	Relogging Into Message Manager
	Remote Access

	9. Troubleshooting
	AT&T Professional Services
	Problem Isolation
	Installation or Setup Problems
	Problems Using Message Manager
	Fax Problems

	A. Hot Keys
	Index
	Addendum 1
	Release 2.2 Features
	Message Manager Installation
	Upgrading to Message Manager Release 2.2
	Distributing Message Manager through the LAN
	Installing a Shared Copy of Message Manager on the...



